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The following updates were made throughout the document:
— Vortex instructions were updated for setting up PCR reactions.

—  Sealing instructions were updated for sealing the OpenArray™ Plate.
—  Minor verbiage updates.

The support email was updated for ordering TagMan™ DME and SNP Genotyping Assay plasmid controls
(“Plasmid controls” on page 133).

The instrument image on the cover page was updated.

D.0

23 May 2022

The TagMan™ OpenArray™ PGx Panel, QuantStudio™ 12K Flex Real-Time PCR System (Cat. No. 4475395)
was removed from the fixed TagMan™ OpenArray™ PGx panel plates product list.

For the DNA isolation procedure, the MagMAX™ DNA Multi-Sample Ultra Kit was replaced with the
MagMAX™ DNA Multi-Sample Ultra 2.0 Kit (Cat. No. A36570).

The following updates were made to the list of required materials for the OpenArray™ Plate workflow:
—  Clear plates were added as an option for the OpenArray™ 384-well Sample Plates.
—  The Biomek™ Seal and Sample Foil Lids were changed to an optional material.
— Asharp edge, a blade, or a scalpel was added.
—  Nuclease-free water was added.
—  The ethanol was updated to 100% molecular grade ethanol.

The location of the sample layout file was corrected for OpenArray™ Sample Tracker Software (applies to
OpenArray™ AccuFill™ Software v1.2 only).

The Biomek™ Seal and Sample Foil Lids were changed to an optional material.
A note was added to recommend a pipetting overage when setting up the PCR reactions.

The centrifuge speed for the OpenArray™ Plate workflow and troubleshooting empty through-holes was
updated.

A new chapter was added for preparing genotyping experiments using EDT files (see Chapter 5, “Prepare
and run OpenArray™ PGx SNP genotyping experiments using EDT files”).

Separate sections for preparing OpenArray™ Plates with OpenArray™ AccuFill™ Software v1.2 and
OpenArray™ AccuFill™ Software v2.0 were added (see Chapter 4, “Prepare and run OpenArray™ PGx SNP
genotyping experiments” and Chapter 7, “Prepare, run, and analyze PGx copy number experiments”).

The chapter for performing translation analysis in AlleleTyper™ Software was removed.

C.0

28 September
2016

Ordering information incorporated into Chapter 2.

DNA isolation procedures moved into Chapter 3.

gDNA preamplification moved to new Appendix B.

Prepare, run, and analyze OpenArray™ PGx experiments split into two chapters.

New troubleshooting sections.

B.0

4 August 2014

DNA sample preparation procedures in Chapter 4 updated for use of the MagMAX™ DNA Multi-Sample Ultra
Kit. Users referred to a new Appendix A for complete procedures.

Perform analysis in TagMan™ Genotyper Software topic in Chapter 5 reorganized for better workflow.
Sample quantification procedure using the RNase P Detection Reagents Kit added to a new Appendix B.

Corrections and clarifications made to Appendix C Troubleshooting.
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About pharmacogenomics
experiments

B INtrodUCHION . .o e e e e e e 10
B O WOTKI OW . o e e e e e e 11

IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Introduction

10

Pharmacogenomics (PGx) is the study of genetic variation as it relates to drug response. PGx studies
involve testing samples for multiple variants in drug metabolism enzyme (DME) and transporter
genes. This guide describes procedures for the sample-to-result PGx workflow solution using the
QuantStudio™ 12K Flex Real-Time PCR System.

Variant testing uses TagMan™ SNP Genotyping Assay or TagMan™ Copy Number Assays targeting DME
genes.

¢ The TagMan™ Drug Metabolism Genotyping Assay collection has ~2,700 assays that detect
potentially causative polymorphisms in 221 drug metabolism enzyme and associated transporter
genes.

* TagMan™ Copy Number Assays examine copy number variation (CNV) in DME genes.

* There are 7 million predesigned TagMan™ SNP Genotyping Assay and custom TagMan™ SNP
Genotyping Assay available for other targets of interest.
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Workflow

Workflow

OpenArray™ Plate PGx SNP genotyping experiments

Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra 2.0 Kit
(page 32)

(Optional) Preamplification of low-concentration gDNA
(page 124)

Prepare and run OpenArray™ PGx SNP genotyping experiments
(page 44)
OR

Prepare and run OpenArray™ PGx SNP genotyping experiments
using EDT files (page 72)

Analyze OpenArray™ PGx SNP genotyping experiments
(page 97)

OpenArray™ Plate PGx copy number experiments

. Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra 2.0 Kit

(page 32)

Prepare, run, and analyze PGx copy number experiments
(page 108)
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DME allele nomenclature

12

SNPs within drug metabolism genes are often identified by their standardized allele name or star (*)
allele nomenclature (Sim, 2010). Star alleles are gene-level haplotypes (a set of DNA polymorphisms
that are often inherited together on the same chromosome). Often, these haplotypes have been
associated with DME activity levels (for example, functional, decreased function, or nonfunctional
variants). The combination of star allele haplotypes (that is, the diplotype) within a sample can be used
to predict its drug metabolizer phenotype (for example, ultrarapid, extensive, intermediate, or poor).
Genetic variants within a haplotype can include SNPs, InDels, and CNVs. The allele nomenclature for a
specific gene family is maintained and standardized by an affiliated group of scientists that curate each
site independently. This nomenclature is complicated, because many alleles contain more than one
polymorphism (that is, they are haplotypes) and conversely, many polymorphisms can be associated
with several alleles.

The star allele nomenclature contains the DME gene name, such as CYP2D6, followed by a numeric
allele name, such as *3. A star allele conventionally contains at least one causative variant (for example,
a frameshift mutation). Variants are given reference gene and/or cDNA coordinates, such as g.2549delA
(full variant name: CYP2D6*3 g.2549delA). The causative star allele variant can be associated with other
nucleotide variants in different haplotypes groups; such sub-alleles are denoted by letters following the
numeric allele identifier (for example, *3A). On the Cytochrome P450 (CYP) Allele Nomenclature web
site, the defining, causative variant for a star allele is often in bold font.

Note: *1 refers to the reference gene sequence, which produces an enzyme with normal function. The
reference gene sequence is not necessarily equivalent to the reference genome assembly sequence,
and it does not necessarily contain the major allele for a given SNP (which can vary between
populations, particularly for highly polymorphic SNPs).
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TagMan™ Drug Metabolism Genotyping Assays

The defining variant for a given DME gene star allele may be the only variant needed to identify that
particular star allele. The defining allele is sometimes referred to as the "tag SNP”. Common allele
names are provided for many DME variants in the PGx Common Markers file. See “The PGx Common
Markers file” on page 28.

The DME Assay collection variants have been mapped for the genes having public allele nomenclature
sites. This allele nomenclature is searchable on the DME assay product pages and in the downloadable
TagMan™ Drug Metabolism Genotyping Assays Index file, available at www.thermofisher.com/pgx.
The public allele nomenclature websites provide information on DME gene star allele haplotypes, the
defining polymorphisms for these alleles, and links to the NCBI dbSNP website for variants having an
reference SNP (refSNP) identifier, or rs ID.

Table 1 DME allele nomenclature websites

Gene family Allele nomenclature website
CYP—Cytochrome P450 (CYP) genes https://www.pharmvar.org/
NAT1 and NAT2—Arylamine http://nat.mbg.duth.gr

N-Acetyltransferase genes

UGT—UDP Gilucuronosyltransferase genes www.pharmacogenomics.pha.ulaval.ca/ugt-alleles-
nomenclature

Note: Other DME gene variants have allele nomenclature reported in the literature, but no public
nomenclature web site exists. For key variants, allele nomenclature is found in the Very Important PGx
(VIP) gene summary pages on the Pharmacogenomics Knowledge Base web site www.pharmgkb.org.

Where possible, such allele nomenclature is provided for non-CYP, -NAT and -UGT variants in the PGx
Common Markers file. See “The PGx Common Markers file” on page 28.

TagMan™ Drug Metabolism Genotyping Assays

The TagMan™ Drug Metabolism Genotyping Assay, a collection of approximately 2,700 assays, detects
potentially causative SNP, MNP or InDel polymorphisms in 221 drug metabolism enzyme (DME) and
associated transporter genes. The DME assays were designed using an optimized DME assay design
algorithm that uses a high level of bioinformatics to enable a lack of underlying polymorphisms and
high target specificity (that is, gene family members and pseudogenes will not amplify). Assays to
more difficult targets underwent manual design. All DME Assays underwent stringent wet-lab testing,
including running with 180 unique DNA samples from four different populations (African American,
Caucasian, Chinese, and Japanese).

The TagMan™ SNP Genotyping Assays were designed using a related, highly validated SNP assay
design algorithm. The SNP assays are functionally tested (that is, for amplification and clustering
capabilities) when first manufactured on 20 unrelated gDNA samples from three populations (African
American, Caucasian, and Japanese). In addition, over 300 high value TagMan™ DME and SNP assays
were tested with 44 African American and Caucasian samples and synthetic templates representing
each genotype on OpenArray™ plates run on the QuantStudio™ 12K Flex Real-Time PCR System, to
facilitate assay performance on this platform.

Pharmacogenomics Experiments Application Guide 13
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Chapter 2 Background and tools for assay selection
TagMan™ Drug Metabolism Genotyping Assays

All TagMan™ SNP Genotyping Assays, Drug Metabolism Genotyping Assays, and Custom SNP
Genotyping Assays contain sequence-specific forward and reverse primers to amplify the polymorphic
sequence of interest and two TagMan™ MGB probes with non-fluorescent quencher (NFQ):

* One probe labeled with VIC™ dye detects the Allele 1 sequence.
* One probe labeled with FAM™ dye detects the Allele 2 sequence.

TagMan™ DME and SNP Genotyping Assay data is analyzed by cluster plot analysis: FAM™ dye signal
is plotted on the Y-axis, and VIC™ dye signal is plotted on the X-axis. Samples homozygous for the
FAM™- or VIC™-labeled alleles form clusters along the Y- or X-axis, respectively, whereas heterozygous
samples contain both FAM™ and VIC™ dye signal and will cluster roughly along the diagonal position
between the homozygous clusters.
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2,500
[ ]
2,250
2,000
1,750
7 Heterozygous
=
< 1,500
[T
(]
a
= 1250
T
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0 o0 .
-250

0 250 500 750 1,000 1,250 1,500 1,750 2,000 2,250
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Genotyping assay context sequences

14

The reporter dye information for TagMan™ Drug Metabolism and SNP Genotyping Assays is
represented in the assay context sequence and provided in the Assay Information File (AIF) that

you can download from the web at www.lifetechnologies.com/OA-platefiles. The context sequence
is the nucleotide sequence surrounding the SNP site. It is provided in the (+) genome strand orientation
relative to the NCBI reference genome. The SNP alleles are included in brackets, where the order of the
alleles corresponds to the association with probe reporter dyes, where [Allele 1 = VIC™ dye / Allele 2 =
FAM™ dye].
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TagMan™ Drug Metabolism Genotyping Assays

Example: C__27102431_DO0 assay

For C__27102431_D0 assay targets the CYP2D6*4 g.1846G>A SNP, rs3892097, and has the following
context sequence:

AGACCGTTGGGGCGAAAGGGGCGTC [C/T] TGGGGGTGGGAGATGCGGGTAAGGG

The VIC™ dye probe is associated with the C allele and the FAM™ dye probe is associated with the T
allele.

In this example, the SNP alleles (C/T) are the reverse complement of those given in the star allele
nomenclature: CYP2D6*4 g.1846G>A. This is because the context sequence alleles are provided in the
(+) reference genome strand orientation whereas the star allele nucleotide changes are provided with
respect to the CYP2D6 gene reference sequence that maps to the (-) genome strand.

TagMan™ Drug Metabolism Genotyping Assay for genotyping triallelic SNPs

Several important DME gene variants are triallelic SNPs, wherein 3 bases occur at the same genomic
location. Triallelic SNP targets can be interrogated using a pair of TagMan™ assays. Each assay
contains one probe for the major SNP allele, which is labeled with the same reporter dye (VIC™ dye)

in both assays, and one probe for one of the minor alleles, which is labeled with the second reporter
dye (FAM™ dye). To generate accurate sample genotypes, the two assays must be run independently on
the same panel of samples, and the resulting allelic discrimination plots must be analyzed in concert,
comparing the genotype cluster positions from both assays to a map of the true sample genotypes. See
Table 12, on page page 103 for analysis.

Table 2 TagMan™ Drug Metabolism Genotyping Assays to triallelic SNPs

Gene rs ID TagMan™ DME Assay Allele name Assay alleles [VIC™/FAM™]
ABCB1 rs2032582 C_11711720C_30 ABCB1 ¢.3095G>T C/A
C_11711720D_40 ABCB1 c.3095G>A C/T
CYP2C9 | rs7900194 C__25625804_10 CYP2C9*8 c.449G>A A/G
C_25625804D_20 CYP2C9*27 c.449G>T T/G
CYP2D6 | rs5030865 C_30634117C_KO |CYP2D6*8 g.1758G>T A/C
C_30634117D_MO CYP2D6*14 g.1758G>A T/C
CYP1A1 | rs41279188 C_30634152C_70 CYP1A1*5 g.2461C>A G/T
C_30634152D_80 CYP1A1*9 g.2461C>T G/A
CYP2C8 | rs72558195 C_72650009C_10 CYP2C8*7 ¢.556C>T G/A
C_72650009D_20 CYP2C8*8 ¢.556C>G G/C
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TagMan™ Drug Metabolism Genotyping Assays

TagMan™ Drug Metabolism Genotyping Assays for genotyping adjacent
SNPs

For certain DME targets, two SNPs are located adjacent to one another. This complicates the SNP
genotype analysis because for each assay, the probes will fail to bind target sequences when the
adjacent SNP is present. However, when the adjacent SNPs are present in only 3 haplotypes, these
SNPs can be interrogated similarly to triallelic SNPs using two assays (see “TagMan™ Drug Metabolism
Genotyping Assay for genotyping triallelic SNPs” on page 15).

Assay sets to two highly studied SNPs that have an adjacent, less frequently detected SNPs, are
available. In each case, the minor alleles of each SNP are not found together in the same haplotype.

Table 3 DME Assays for genotyping adjacent SNPs

Gene SNP ID TagMan™ DME assay Allele name
CYP2C19 rs4244285 C__25986767_70 CYP2C19*2 681G>A
rs6413438 C__30634128_10 CYP2C19*10 ¢.680C>T
CYP2C9 rs1057910 C__27104892_10 CYP2C9*3 c.1075A>C
rs56165452 C__30634131_20 CYP2C9*4 c. 1076T>C

CYP2C19*2,"10 adjacent SNP assays

Only 3 haplotypes have been observed for the CYP2C19 *2 and *10 SNPs (https://
www.pharmvar.org/gene/CYP2C19): the rare *10 c.680T allele and the *2 ¢.681A do not occur on the
same chromosome. Thus, these adjacent SNPs can be analyzed similarly as for triallelic SNPs. When
the *2 assay is run on a sample containing a *10 allele, the probes will fail to detect the *10-containing
allele; the converse is true when the *10 assay is run on a sample containing a *2 allele. The context
sequences for each assay are shown below. After running paired assays for adjacent SNPs in separate
reactions on the same gDNA samples, examine the cluster plots in TagMan™ Genotyper Software.
Sample calls may need to be adjusted, and the results of each assay compared to determine the

true sample genotype, as detailed in “Analysis guidelines: DME genotyping assays for genes in copy
number variation regions” on page 103.

CYP2C19*2 ¢.681G>A C__25986767_70

TTCCCACTATCATTGATTATTTCCc [A/G] GGAACCCATAACAAATTACTTAAAA

CYP2C19*10 ¢.680 C>T C__30634128_10

TTTCCCACTATCATTGATTATTTCC [C/T] gGGAACCCATAACAAATTACTTAAA
10 2

TTTTCCCACTATCATTGATTATTTCC[C/T] [G/A]GGAACCCATAACAAATTACTTAAA
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TagMan™ Copy Number Assays

Copy number variation must be assessed for DME genes known to exhibit copy number variation
(see “Pre-tested TagMan™ Copy Number Assays for select DME genes” on page 18). TagMan™ Copy
Number Assays are run simultaneously with a TagMan™ Copy Number Reference Assay in a duplex
real-time polymerase chain reaction (PCR). TagMan™ Copy Number Assays detect the target gene or
genomic sequence of interest and the TagMan™ Copy Number Reference Assay detects a sequence
known to exist in two copies in a diploid genome (for example, the human RNase P H1 RNA gene).
Relative quantitation (RQ) using the comparative C; (AAC;) method is used to determine the number of
copies of the target sequence in each test sample.

* TagMan™ Copy Number Assays contain two primers and a FAM™ dye-labeled MGB probe to detect
the genomic DNA target sequence.

* TagMan™ Copy Number Reference Assays contain two primers and a VIC™ dye-labeled TAMRA™
probe to detect the genomic DNA reference sequence.

TagMan™ Copy Number Assays are ordered as single tube assays (see “Single tube products and
formats” on page 30) and run on 96-well and 384-well plates on Applied Biosystems™ Real-Time
instruments, including the QuantStudio™ 12K Flex Real-Time PCR System. There are currently no copy
number assays developed for the OpenArray™ plate.

DME genes and copy number variation

Several DME genes exhibit copy number variation (CNV) or other structural alterations due to
recombination and gene conversions events between highly related loci (He, 2011).

For DME gene variants that are associated with copy number variation, run both DME genotyping
assays and copy number assays to determine sample genotypes.

For DME assays that target a deleted or duplicated gene (for example, CYP2D6):
* samples that contain 0 copies of the gene will not amplify.
¢ samples with 1 or more gene copies that are homozygous for the SNP allele will cluster together
¢ samples with more than 2 gene copies that are heterozygous may run within the 2-copy
heterozygous cluster or between it and one of the homozygous clusters.

To discern the sample genotype, copy number quantitation of the gene target must be done to
determine which samples carry gene deletions or duplications. Additionally, use of multiple copy
number assays for a gene may be required for hybrid gene analysis.

Note: The copy number assays are not SNP allele-specific and cannot be used to determine which
SNP allele is duplicated when a sample is heterozygous and has three gene copies.

A protocol has been developed for determining allele-specific copy number of CYP2D6 alleles by
digital PCR. For more information, see CYP2D6 Allele-specific Copy Number Analysis Quick Reference
(Pub. No. MAN0011114).
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Pre-tested TagMan™ Copy Number Assays for select DME genes

Pre-tested TagMan™ Copy Number Assays are available for the DME genes in CNV regions are shown
in Table 4. These assays were run on 90 Coriell gDNA samples from African American and Caucasian
populations (the same panel used for DME Assay validation).

Table 4 Pre-tested DME gene TagMan™ Copy Number Assays for CNV and hybrid gene analysis

Gene symbol Assay ID Gene location Major alleles detected

CYP2D6 Hs00010001_cnl'] Exon 9 CYP2D6 Deletion (*5); Duplications (for example, *1xN, *2xN,
*4x2, *9x2,*10x2, *17xN, *35x2)

CYP2D6 Hs04083572_cn Intron 2 CYP2D6 Deletion (*5); Duplications (for example, *1xN, *2xN,
*4x2, *9x2,*10x2, *17xN, *35x2); 2D6/2D7 hybrid alleles with 2D7
exon 9 sequences (for example, *36, *83)

CYP2D6 Hs04502391_cn Intron 6 CYP2D6 Deletion (*5); Duplications (for example, *1xN, *2xN,
*4x2, *9x2,*10x2, *17xN, *35x2); 2D6/2D7 hybrid alleles with 2D7
exon 9 sequences (for example, *36, *83)

CYP2A6 Hs07545273_cn Exon 1 CYP2AG6 Deletion (*4); Duplication (*1x2)

CYP2A6 Hs07545274_cn Intron 1 CYP2A6 Deletion (*4); Duplication (*1x2)

CYP2A6 Hs04488984_cn Intron 2 CYP2A6 Deletion (*4); Duplication (*1x2); hybrid allele with 2A7
exons 1-2 and 2A6 exons 3-9 (*12)

CYP2A6 Hs07545275_cn Intron 7 CYP2A6 Deletion (*4); Duplication (*1x2); hybrid allele with 2A7
exons 1-2 and 2A6 exons 3-9 (*12)

CYP2A7 Hs07545276_cn Exon 1 CYP2A6 hybrid allele with 2A7 exons 1-2 and 2A6 exons 3-9
(*12)

CYP2A7 Hs04488016_cn Intron 2 CYP2A6 hybrid allele with 2A7 exons 1-2 and 2A6 exons 3-9
(12)

CYP2A7 Hs07545277_cn Intron 7 No CYP2AG6 alleles

CYP2E1 Hs00010003_cn Promoter CYP2E1 Duplication (*1x2)

GSTM1 Hs02575461_cn Exon 1 GSTM1 Deletion (*0); Duplication

GSTT1 Hs00010004_cn Intron 1 GSTT1 Deletion (*0)

SULT1A1 Hs03939601_cn Intron 2 SULT1A1 Deletion; Duplication

UGT2B17 Hs03185327_cn Exon 1 UGT2B17 in 150 kb Deletion (*2)

1 Assays in boldface type are those most frequently used for CNV and hybrid gene analysis.

18
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CYP2D6 copy number variation and CYP2D6/CYP2D7 hybrid alleles

The CYP2D6 gene is the most highly polymorphic and complex of the DME genes. Over 100

star allele groups have been identified by the Cytochrome P450 Nomenclature Committee (https://
www.pharmvar.org/). At least 4 of these groups give rise to alleles with substrate-dependent reduced
enzyme activity, and more than 20 do not encode functional enzymes.

The CYP2DE6 alleles are composed of SNP and InDel variants, CNVs, and hybrid alleles formed

by recombination between CYP2D6 and highly related upstream pseudogene, CYP2D7, sequences.
Individuals may carry null alleles (*5) or extra copies of CYP2D6 (*1, *2, *4, *9,*10, *17, *35). Some
CYP2D6 alleles contain sequences derived from the highly homologous CYP2D7 pseudogene; for
example, CYP2D6*36, as well as *4N, *57, and *83, contains a gene conversion to CYP2D7 sequences
in exon 9 associated with negligible CYP2D6 enzyme activity (Gaedigk, 2006).

Three different copy number assays to CYP2D6 sequences are available for determining CYP2D6 gene
copy number and to aid identification of some hybrid alleles (see “Pre-tested TagMan™ Copy Number
Assays for select DME genes” on page 18):

Table 5 Pre-tested TagMan™ Copy Number Assays to CYP2D6: detection of CYP2D7 exon 9
conversion alleles

Gene Assay ID Gene location CYP2D6 full length CYP2D6*3§ CYP2D7 full length
alleles [2D6/2D7 hybrid]["] alleles
CYP2D6 | Hs00010001_cn Exon 9 Yes No No
Hs04083572_cn Intron 2 Yes Yes No
Hs04502391_cn Intron 6 Yes Yes No

[ Other alleles with conversions to CYP2D7 sequences in exon 9: *4N, *57, *83

The primary copy number assay for CNV analysis is the exon 9 Hs00010001_cn assay, which
predominantly detects full-length CYP2D6 alleles and not hybrid alleles containing the exon 9
conversion to CYP2D7 sequences. Usually it is not necessary to detect these nonfunctional hybrid
alleles as they not contribute to CYP2D6 metabolizer status (see category A samples in Table 6).

The intron 2 and/or intron 6 assays should be run, in addition to the exon 9 assay, when information for
both CYP2D6 and hybrid alleles is needed (see Table 6), for example, to characterize samples that are:

* Category B—O0 copies for the exon 9 assay, but show amplification by SNP assays upstream of
exon 9 may carry a *36 allele.

¢ Category C—single copy for the exon 9 assay, but are heterozygous for SNPs upstream of exon 9
may carry a *36 allele.

* (Category D—single copy for the exon 9 assay, but 5’ located SNP assays do not amplify and may
carry a *13 allele.

* Category E—2 copies for the exon 9 assay and carry a *13 allele. Such samples, which are
relatively rare, are difficult to detect unless all 3 CYP2D6 CNV assays are routinely run.
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Table 6 Example CYP2D6 SNP and copy number assay results for samples carrying hybrid alleles with

CYP2D7 sequences
SO S SNP assay results (cDNA alleles) Copy number assay results e e il
100C>T| 1846G>A | 2850C>T | 4180G>C | exon 9 | intron 6 | intron 2 | 80N 9 result only!

A *10/*36 T/T G/G C/C C/C 1 2 2 *5/*10
A *2/*36-*10| C/T G/G C/T C/C 2 3 3 *2/10
A *4/*36-*10| T/T G/A C/C C/C 2 3 3 *4/*10
A *1/*4N-*4 | C/T G/A C/C G/C 2 3 3 “1/*4
B *5/*36 T/T G/G C/C no amp 0 1 1 und (= *5/*5)
C *4/*36 T/T G/A C/C C/C 1 2 2 und (= *4/*5)
C *1/*36-*36| C/T G/G C/C G/G 1 3 3 und (= *5/*1)
D *5/*13F | noamp | noamp | noamp G/G 1 0 0 und (= *5/*5)
E “10/13E | T/T G/G C/C C/C 2 1 1 *10/*10

01 und = undetermined

See The Human Cytochrome P450 (CYP) Allele Nomenclature Database CYP2D6 web page
(https://www.pharmvar.org/gene/CYP2D6) or the PharmGKB web page (www.pharmgkb.org), plus
associated references, for more details about these alleles.

IMPORTANT! Always use the CYP2D6 exon 9 copy number assay to detect true gene duplication
events. CYP2D6 intron 2 or intron 6 copy number assays should not be used alone to detect CYP2D6
duplications as they will also detect nonfunctional hybrid alleles that do not represent duplications and
that do not contribute to CYP2D6 metabolizer status.

CYP2A6 copy number variation and CYP2A6/CYP2A7 hybrid alleles

20

CYP2AG alleles defined by the Cytochrome P450 Nomenclature Committee (https://
www.pharmvar.org/) include at least four non-functional alleles and several reduced function alleles.
The genotyping of CYP2A6 alleles is complicated by the presence of copy number variant deletion

(*4) and duplication (*1) alleles, and hybrid alleles formed by recombination with upstream pseudogene
CYP2AY sequences, for example, the reduced function *12 allele contains exons 1-2 of CYP2A7 origin
and exons 3-9 of CYP2AG origin (Oscarson, 2002).
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Several copy number assays to CYP2A6 and CYP2A7 sequences are available for examining copy
number variants and hybrid alleles (see “Pre-tested TagMan™ Copy Number Assays for select DME
genes” on page 18 for the complete list).

Table 7 Pre-tested TagMan™ Copy Number Assays to CYPAD6 and CYP2A7: detection of hybrid

alleles
Gene Assay ID Gene location CYPZA:ISI ;:glslength CYP2A'61;1b2ri£j2]A7/2A6 CYPZAaT| ;:glslength

CYP2AG6 | Hs07545273_cn Exon 1 Yes No No
Hs07545274_cn Intron 1 Yes No No
Hs04488984 cn Intron 2 Yes Yes No
Hs07545275 _cn Intron 7 Yes Yes No

CYP2A7 | Hs07545276_cn Exon 1 No Yes Yes
Hs04488016_cn Intron 2 No Yes Yes
Hs07545277_cn Intron 7 No No Yes

At least two assays are required to detect copy number variation in CYP2AG6.

* The CYP2AG6 intron 7 assay can be used to detect *4 deletion and *1 duplication alleles. This
assay will amplify both full length CYP2A6 and the partially active CYP2A6/CYP2A7 hybrid allele,
CYP2A6*12, but will not be able to discern them.

* The intron 1 assay can also be used to detect *4 deletion and *1 duplication alleles. This assay will
amplify full length CYP2A6 but will not be able to amplify the CYP2A6*12 hybrid allele.

¢ |f both CYP2A6 assays are run, samples containing *12 alleles can be distinguished from those
containing full-length alleles. For example, a *1/*12 sample will give 2 copies using the intron 7
assay and 1 copy using the intron 1 assay, whereas a *1/*1 sample will give 2 copies with both
assays.

Additionally, CYP2A7 assays can be used to corroborate the presence of CYP2A6*12 alleles: The
CYP2A7 exon 1 assay will amplify the hybrid CYP2A6*12 allele, whereas the intron 7 assay will not
amplify intact CYP2A6 or the CYP2A6*12 allele.

GSTM1 and GSTT1 DME assays and CNV

The GSTM1 and GSTT1 genes have a very high frequency of deletion and are entirely missing in a
substantial number of individuals in multiple populations. DME genotyping assays to variants within
these genes will not amplify samples that are homozygous for the gene deletion; samples that are
heterogyous for the deletion will run as a homozygous sample.

Pharmacogenomics Experiments Application Guide
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Special assays

Gender assays

Gender-specific assays in PGx studies can aid sample tracking. The TagMan™ SNP Genotyping
Assay, C_990000001_10, targets a gender-specific polymorphic region in the amelogenin gene that

is commonly used in forensic sex determination tests. The VIC™ dye probe detects a 6 base deletion
which occurs in the X-specific amelogenin gene, whereas the FAM™ dye probe detects Y-chromosome
sequences. In genotyping experiments, male samples run in the heterozygous cluster position and
female samples run in the VIC™ homozygote cluster. Some males lack the Y-specific amelogenin

gene, and will type as female. Run the C_990000001_10 assay in combination with a Y-chromosome
assay to identify any mistyped samples. For more information, go to www.cstl.nist.gov/strbase/
Amelogenin.htm.

An example of a genotyping bar code Y-chromosome assay is the C___1083232_10 assay to the
polymorphic rs2032598 SNP in USP9Y. Only male samples amplify with this assay; female samples will
cluster with the no template controls (NTCs).

Clinical research targets

TagMan™ SNP Genotyping Assays for non-ADME PGx targets and clinical research targets are often
included in PGx studies. These assays are found within the predesigned TagMan™ SNP Genotyping
Assays collection and are searchable on the Thermo Fisher Scientific web site by NCBI dbSNP rs ID.
Note that common names for disease-associated alleles (for example, Factor V Leiden) are not yet
searchable terms. Public web sites that can be used to identify the rs ID for common disease alleles
include:

* Pharmacogenomics Knowledge Base (PharmGKB): www.pharmgkb.org
* Online Mendelian Inheritance in Man™ (OMIM®): http://omim.org/
¢ SNPedia (a wiki investigating human genetics): http://snpedia.com/
In addition, TagMan™ SNP Genotyping Assays for commonly tested clinical research targets

are included in the PGx Common Markers file. Download the PGx Common Markers file from
www.thermofisher.com/pgx.

PGx targets not amenable to TagMan™ design

22

TagMan™ SNP Genotyping Assays are an ideal technology for interrogation of most DME and clinical
research target polymorphisms, offering highly specific target amplification and allele discrimination.
However, there are some polymorphisms that are not well-suited for TagMan™ Assay development.
These include targets that:

* Reside in highly polymorphic genomic regions (polymorphisms interfere with amplification in some
samples)

* Share high sequence identity with another genomic region (base differences are not available for
specific assay development)

* Are microsatellite polymorphisms
* Are base deletions within a homopolymer sequence

Pharmacogenomics Experiments Application Guide


http://www.cstl.nist.gov/strbase/Amelogenin.htm
http://www.cstl.nist.gov/strbase/Amelogenin.htm
http://www.pharmgkb.org
http://omim.org/
http://snpedia.com/
http://www.thermofisher.com/pgx

Chapter 2 Background and tools for assay selection M
Tools for finding PGx TagMan™ DME, SNP, and Copy Number Assays | =

The PGx Common Markers file (www.thermofisher.com/pgx) contains a list of commonly requested
DME and clinical research targets that are not good candidates for TagMan™ Assay design and
suggestions for alternative technologies to use (see the 'No TagMan Assays' tab).

Custom TagMan™ SNP Genotyping Assays

Targets of interest that are not covered by the current TagMan™ SNP Genotyping Assay collection can
be submitted for Custom TagMan™ SNP Genotyping Assays design.

The Custom TagMan™ Assay Design Tool (CADT) is available at www.thermofisher.com/
tagmansnpdesign.

Order Custom TagMan™ SNP Genotyping Assays by first entering a sequence with the SNP
in brackets, for example [A/G], then submitting the chosen target sites for assay design. See
www.thermofisher.com/tagmansnpdesign.

CADT is used to design assays targeting biallelic SNPs or insertion/deletion polymorphisms and
multi-nucleotide polymorphisms (MNPs) that are 6 bases or fewer in length.

Sequences must be SNP and repeat-masked before submission to CADT. Additionally, the genome-
uniqueness for assays must first be established, because custom assays are not compared to the
genome (for example, by BLAT or BLASTn) to determine target specificity. Do not submit targets from
the “No TagMan Assays” tab (see “PGx targets not amenable to TagMan™ design” on page 22), as
assays can be designed that do not function properly.

For targets that present assay design challenges, contact our fee-for-design custom assay design
service at custom.solutions@Ilifetech.com.

TagMan™ Copy Number Assays

Targets of interest that are not covered by the extensive human TagMan™ Copy Number Assays
collection can be submitted to TagMan™ Copy Number Assays design. The GeneAssist™ Copy Number
Assay Workflow Builder is available at www.thermofisher.com/order/custom-genomic-products/
tools/copy-number-variation.

Tools for finding PGx TagMan™ DME, SNP, and Copy
Number Assays

* Assay search tool available at www.thermofisher.com/ordertagman

* TagMan™ Drug Metabolism Genotyping Assays Index available at www.lifetechnologies.com/
tagmanandme

* PharmaADME Core Marker Set available at http://tools.lifetechnologies.com/content/sfs/
brochures/cms_082106.xls

* PGx Common Markers file available at www.thermofisher.com/pgx
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Assay Search tool

The Thermo Fisher Scientific web site provides an easy-to-use assay search tool to aid selection of
TagMan™ DME, SNP and Copy Number Assays. The search tool can be accessed from the Real-Time
PCR Assays page or any of the specific product pages at thermofisher.com.

Search for TagMan™ SNP Genotyping Assays

1. Go to www.thermofisher.com/ordertagman.

2. Select SNP Genotyping.

\\ If; Gene Expression

All SNP Genotyping

Number

v

What type of experiment are you conducting?

kE/ SNP Genotyping
I

What type of assay do you want?

Drug Metabolism Assays

[Hs] Human [Mm] Mouse All

® Enter target information

[CY Enter / Upload Multiple Targets

Include 10kb Flanking Region

Position/Start

Assay Search Tool - Find & Buy Your Single Tube TagMan® Assays:

Q MicroRNA j?' Mutation Detection \1 r"

What species do you want to target? (Select one or more)

e.g., Assay |1D, dbSNP ID, Gene Symbol, hCV ID

What chromosome position are you interested in?

]
Y|
-

Copy Number é‘; siRNA

Antibodies

Position/Stop

Search

3. Select All SNP Genotyping » Human (includes the DME Assays) or just the validated Drug
Metabolism Assays collection.

24
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4. Enter target information, then click Search to search the complete assay set.

Optionally, specify other search terms (including allele nomenclature, rs ID and Assay ID) or specify
chromosome position. Use the Enter/Upload Multiple Targets option to specify multiple search
terms.

Note: If allele nomenclature is used as a search term (for example, CYP2D6*4), all DME assays

to variants within all associated sub-alleles will be returned. If needed, review the variants on the
associated allele nomenclature website to determine which are important to evaluate in your study
(for example, only the allele-defining variants may be of interest).

IMPORTANT! Read any Important Information notes associated with the assay (select Important
Information beside the Assay ID on the assay search results bar to open a pop-up window). These
notes provide information required for making ordering decisions. For example, a copy number
assay may be required in addition to the DME assay for sample genetic analysis, or the DME assay
may be one of a pair of assays interrogating a triallelic SNP.

5. To review the information for each assay, click View Assay on Map, View Details, and View
Allele Frequency (if available).

Note the following:
* Read any Important Information notes associated with the assay (select Important

Information next to the Assay ID). Notes provide information required to make ordering
decisions and analyze data.

* The annotation for triallelic SNP assays is associated with the SNP ID and not to the assay.
Review the Important Information or the assay context sequence to determine the target
alleles of each assay.

* C(Click View Details to review allele nomenclature for CYP, UGT, and NAT genes.

6. To prepare a list of assays for ordering, select the assays of interest, then click Export (at the top
of the page).

The exported results contain the Assay ID and annotations (catalog number, SNP, gene, context
sequence, genomic location, and allele nomenclature).
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Search for TagMan™ Copy Number Assays

26

. Go to www.thermofisher.com/ordertagman.

2. Select Copy Number » Human.

Assay Search Tool - Find & Buy Your Single Tube TagMan Assays:

What type of experiment are you conducting?

% Gene Expression kE/ SNP Genotyping : = Copy Humber é':? siRNA
- y =z
9 MicroRHA ?’/ Mutation Detection \1 r’ Antibodies Engineered Cell Models

Which Copy Number product|s) are you interested in using?

All Copy Number Assays Markers & Reporters

What species do you want to target? (Select one or more)

[Hs] Human [Mm] Mouse All

@ Enter target information

e.g., Assay ID, Gene Symbol/Name, Refseq, DGV
@ Enter / Upload Multiple Targets
) What chromosome position are you interested in?

MNumber Position/Start Position/Stop

- [d

3. Enter target information. Search terms include gene symbol, Assay ID, and Database of Genomic

Variants (DGV) variation IDs.

* Under Narrow Your Results (to the left of the results), select the Gene name and Pre-tested
Assaly filters.

* Use the Enter/Upload Multiple Targets option to specify multiple search terms.
* Specify chromosome position.

Note: Copy Number Assays must be run in duplex PCR with a TagMan™ Copy Number Reference
Assay; RNase P (default assay) and TERT (alternate assay) assays are available.

IMPORTANT! Read any Important Information notes associated with the assay (select Important
Information beside the Assay ID on the assay search results bar to open a pop-up window). These
notes provide information required for making ordering decisions. For example, information on the
particular star alleles that an assay detects.

4. Click Search to search the complete assay set.
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5. When applicable, narrow results by selecting Pre-Tested Assays to view assays pre-tested on 90

Coriell gDNAs.

Review the information for each assay: click View Assay on Map and View Details.
Note the following:

* Read any Important Information notes associated with the assay (click the Important
Information box next to an Assay ID). Notes provide information required to make ordering
decisions, then analyze data.

* View Details provides target location within gene and targeted known copy number variants.

If you need a list of assays for ordering, select the assays of interest, then click Export (at the top
of the page).

The exported results contain the assay ID and annotations (catalog number, gene, genomic
location, and DGV targets).

Note: TagMan™ Copy Number Assays must be run in duplex PCR with a TagMan™ Copy Number
Reference Assay: RNase P (default assay) and TERT (alternate assay) assays are available.

The TagMan™ Drug Metabolism Genotyping Assays Index

The TagMan™ Drug Metabolism Genotyping Assays Index contains a comprehensive list of the DME
assays along with the annotations listed below. This file can facilitate looking for DME assays to
polymorphisms of interest given the extensive annotation information within it, which includes:

Gene symbol and name

NCBI SNP reference (if applicable)

Polymorphism (for example, A/G)

Amino acid change (if applicable)

Allele nomenclature (if available)

Polymorphism (for example, A/G)

SNP type (for example, missense mutation)

Context sequence [VIC™/FAM™] (in (+) strand orientation with SNP alleles in brackets)

Applied Biosystems™ minor allele frequency data (Caucasian, African American, Japanese, Chinese
populations)

The PharmaADME Core Marker Set

The PharmaADME consortium created a consensus list of known and putative functional variants
in key genes involved in the absorption, distribution, metabolism, and excretion (ADME) of drugs.
The PharmaADME Core Marker Set contains a list of variants considered most likely to impact drug
metabolism, and is composed of 184 variants in 33 key ADME genes.

Thermo Fisher Scientific developed TagMan™ Assays to the PharmaADME Core Markers (>95%
coverage). This assay set is comprised of both TagMan™ DME and Copy Number Assays to 172 SNP,
InDel, and CNV targets:

164 DME assays include 10 assays to genotype 5 triallelic SNPs (paired assays)
10 copy number assays cover deletions and duplications in 6 total DME genes
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The PGx Common Markers file

28

Thermo Fisher Scientific has pretested over 300 TagMan™ DME and SNP Assays to highly studied,
important DME and other PGx gene variants on OpenArray™ plates run on the QuantStudio™ 12K Flex
Real-Time PCR System. All assays on this list were tested on this system with 44 Coriell gDNAs (22
each African American and Caucasian samples, a subset of the DME Assay 90 sample validation panel)
and most were also tested with synthetic plasmid constructs representing each genotype. The PGx
Common Markers file contains a list of the most commonly requested assays from this set.

The file includes common allele names, context sequences, and other useful annotations.

Note: A presentation called TagMan™ Drug Metabolism Genotyping Assays on OpenArray™ Plates
contains screen shots of the test data for the most commonly requested PGx Marker Assays (download
from www.thermofisher.com/pgx).
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Plate products and formats

Fixed TagMan™ OpenArray™ PGx panel plates

TagMan™ OpenArray™ PGx panel available for use:

* TagMan™ OpenArray™ PGx Express Panel, QuantStudio™ 12K Flex Real-Time PCR System
(Cat. No. 4488847)

Order custom OpenArray™ plates
1. Go to thermofisher.com/order/custom-array.
2. For array type, select TagMan™ OpenArray™ Genotyping Plates.
3. Click View Layout to display the assay format in a plate.

4. Click Select to configure a plate.

Array name" Array ID  Array type Format Unique Targets Filled Invalid Empty
TagMan® OpenArray® Genotyping Plates 640 0 n n m
Select Edit Move Export Help Save Your Array

Click to select assays | Click & drag to move assays | Ciri+C to copy an assay | Ciri+V/ 10 paste an assay

1 2 3 H 5 6 7 8
Display Assay Target v

~ : D Sub Array Al

Filled 0
Invalid 0
Empty

9 f there are any questions,

pleas.

5. Click Import Your Assay List, then provide assay information.

* Under Upload a list of Assay IDs, click Choose File, then select a tab-delimited text file (.txt)
containing Assay IDs.

or

¢ Under Enter a list of Assay IDs, paste the Assay IDs, then click Import Entered List.

6. Follow the screen instructions to configure the assays on the plate.
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7. (Optional) Click Save Your Array at any time to save the array configuration to your Thermo Fisher
Scientific account.

8. When the plate is configured, click Complete Your Design, then follow the screen instructions to
complete the order.

Single tube products and formats

Order single-tube TagMan™ assays

Order single-tube assays in two ways:

* Search for TagMan™ Assays, add assays to the shopping cart, then complete the order.

* [f you have already obtained catalog numbers and IDs (Assay IDs), click Quick Order at the top of
any page at thermofisher.com.

| Qick Order :ﬂ‘

Formats for DME and CNV assays

TagMan™ SNP Genotyping Assays
Table 8 Single-tube TagMan™ SNP Genotyping Assays

Number of reactions Cat. No.
Item Scale Assay mix formulation
384-well 96-well Human | Non-human
Predesigned SNP Small 1,500 300 40X 4351379 N/A
Medium 5,000 1,000 4351376
Large 12,000 2,400 80X 4351374
DME Small 750 150 20X 4362691
Custom SNP Small 1,500 300 40X 4331349 | 4332077
Medium 5,000 1,000 4332072 4332075
Large 12,000 2,400 80X 4332073 4332076

Note: For more detailed instructions on running SNP genotyping experiments with single tube assays,
see the TagMan™ SNP Genotyping Assays User Guide (Pub. No. MAN0009593).

DME assays are available only as small-scale inventoried product. Predesigned and custom SNP
assays are made-to-order and are available in multiple scales.

Assays with human part numbers undergo functional testing on a panel of 20 unrelated Coriell cell line
gDNA samples from 3 populations (African American, Caucasian, and Japanese) before shipment upon
first order.
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Options for master mixes

Custom non-human part numbers can be applied to assays for human targets that would fail the human
assay functional test (for example, Y chromosome SNP assays fail as 8 of 20 samples are female
and will not amplify; GSTT1 and GSTM1 SNP assays will also fail due to the high frequency of gene

deletion).

TagMan™ Copy Number Assays

Table 9 Made-to-order assays

Number of reactions

Cat. No. (Human)

Scale Assay mix
ag4-well | 96-well formulation Pre-designed Custom Plus Custom
assays assays assays
Small 720 360 20X 4400291 4442487 4400294
Medium 1,500 750 4400292 4442520 4400295
Large 5,800 2,900 60X 4400293 4442488 4400296

Table 10 Inventoried assays

Number of reactions
Item Assay mix formulation | Cat. No.
384-well | 96-well

TagMan™ Copy Number Reference Assay RNase 1,500 750 20X 4403326
P (1 tube)
TagMan™ Copy Number Reference Assay RNase 6,000 3,000 20X 4403328
P (4 tubes)
TagMan™ Copy Number Reference Assay TERT (1 1,500 750 20X 4403316
tube)
TagMan™ Copy Number Reference Assay TERT (4 6,000 3,000 20X 4403315
tubes)

Options for master mixes

TagMan™ OpenArray™ Genotyping Master Mix is required for use with OpenArray™ plates. TagPath™
ProAmp™ Master Mix is recommended for optimal performance with TagMan™ Copy Number Assays for

pharmacogenomics applications.

ltem Use Cat. No.
TagMan™ OpenArray™ Genotyping Master Mix OpenArray™ genotyping 4404846
TagPath™ ProAmp™ Master Mix Copy number experiments A30865
(ROX™)
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Isolate DNA using the MagMAX™

DNA Multi-Sample Ultra 2.0 Kit

Kit contents and storage

Reagents provided in the kit are sufficient for 100 reactions.

Table 11 MagMAX™ DNA Multi-Sample Ultra 2.0 Kit (Cat. No. A36570)

Kitcontentsand storage ...
Required materials not supplied ......... ... i
Download the KingFisher™ Flex program (if needed) .....................
Setupthesamplelayout ....... ... . i
Isolate DNA from buccal swabs ........... ..
Isolate DNA from whole blood ......... ... ... it
Prepare a DNA stock solution for OpenArray™ experiments ...............

Normalize DNA samples for copy number analysis .......................

Component Quantity Storage
Enhancer Solution 4.5 mL
Proteinase K 4.5 mL
Binding Solution 45 mL
15-30°C
DNA Binding Beads 4.5 mL
Wash | Solution 110 mL
Elution Solution 12 mL

For 1,000 reaction volume use Cat. No. A36578 (Proteinase K), A36579 (DNA Binding Beads), A36580
(Wash | Solution), A36581 (Lysis/Binding Solution), A36582 (Elution Solution), and A36583 (Enhancer

Solution).
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G

B

Required materials not supplied

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that

the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

ltem Source
Instrument
Magnetic particle processor
KingFisher™ Flex Magnetic Particle Processor 96DW with 96 deep-well head 5400630
Consumables
Deep-well plates, one of the following:
KingFisher™ 96 Deep-Well Plates, v-bottom, polypropylene 95040450
KingFisher™ 96 Deep-Well Plates, barcoded 95040450B
96-well standard plate (elution step)
KingFisher™ 96 KF microplate 97002540
Tip comb, compatible with the magnetic particle processor
KingFisher™ 96 tip comb for DW magnets 97002534
Equipment
Incubator with metal racks MLS
Plate shaker, capable of shaking plates at a minimum of 900 rpm 88880023
Adjustable micropipettors MLS
Multi-channel micropipettors MLS
Reagents
Ethanol, 96-100% (molecular biology grade) MLS
Nuclease-free water AM9932
gahéasspz:\;;c,epb:f;i)ed saline 10010023
Materials
MicroAmp™ Clear Adhesive Film 4306311
4N6FLOQSwabs™, regular tip 4473979
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Download the KingFisher™ Flex program (if needed)

The program required for this protocol is not pre-installed on the KingFisher™ Flex Magnetic Particle

Processor.

1. On the MagMAX™ DNA Multi-Sample Ultra 2.0 Kit web page, scroll down to the Product

Literature section.

2. Click MagMAX_Ultra2_Direct_v2_FLEX to download the program to your computer.

3. See Thermo Scientific™ KingFisher™ Flex User Manual (Cat. No. NO7669) and Bindlt™ Software
User Manual (Cat. No. NO7974) for instructions for installing the program on the instrument.

Set up the sample layout

Set up the sample plate layout using the SampleFile 384-Well Plate 192-Format.xlsx.

Consider including 1 no-template control (using Nuclease-free water) to be run with test samples on the

OpenArray™ plate.

Tool

Obtain from

Description

SampleFile 384-
Well Plate 192-
Format.xlsx

thermofisher.com/

oaqrc

Contains a sample layout tab, additional sample
tracking tabs, and instructions for using an
adjustable pipettor to transfer samples from the
96-well plate to the 384-well sample plate.

34
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Isolate DNA from buccal swabs

Isolate DNA from buccal swabs

This section contains brief procedures. For detailed information, see MagMAX™ DNA Multi-Sample Ultra
Kit (human buccal swabs) User Guide (Pub. No. MAN0010293).

Refer to Best Practices for Collection of Buccal Swabs Quick Reference (Genotyping Experiments)
(Pub. No. MAN0014348) for sample collection instructions.

General guidelines

Perform all steps at room temperature (20-25°C) unless otherwise noted.

Precipitates and high viscosity can occur if Enhancer Solution and Binding Solution are stored
when room temperature is too cold. If this occurs, warm them at 37°C and gently mix to dissolve
precipitates and reduce viscosity. Avoid creating bubbles.
Yellowing of the Binding and Wash | Solution is normal and will not affect buffer performance
Cover the plate during the incubation and shaking steps to prevent spill-over and cross-
contamination. The same MicroAmp™ Clear Adhesive Film can be used throughout the procedure,
unless it becomes contaminated.
If using a plate shaker other than the recommended shaker, verify that:

a. The plate fits securely on the plate shaker.

b. The recommended speeds are compatible with the plate shaker (Ideal shaker speeds allow for
thorough mixing without splashing).

Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To calculate volumes
for other sample numbers, refer to the per-well volume and add 10% overage.

(Optional) To prevent evaporation and contamination, cover the prepared processing plates with
paraffin film or MicroAmp™ Clear Adhesive Film until they are loaded into the instrument.

Before first use of the kit

Prepare Wash Il Solution: Make 80% ethanol from 100% absolute ethanol and Nuclease-Free Water.

Before each use of the kit

Vortex DNA Binding Beads to fully resuspend the beads before each use.

Prepare samples and digest with Proteinase K

Equilibrate buccal swabs to room temperature, before performing isolation, to maximize DNA recovery.

1.

Place one swab, swab-head down, into a deep-well plate.

Note: When a higher concentration of DNA is required, process two swabs in one well and
proceed with the isolation as indicated.

Break enough of the stick off the swab so that the swab sits in the well without protruding.

The recommended swabs have an easy break point, below the swab, that appears as a slight
indentation in the stick portion of the swab.
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3.

4,

Prepare sufficient Proteinase K Mix according to the following table, then gently invert or pipet up
and down several times to thoroughly mix components.

Component [11 Volume per well Volume per platel? (96 samples)
Enhancer Solution 40 pL 4.22 mL
PBS 400 pL 42.24 mL
Proteinase K 40 pL 4.22 mL
Total volume 480 pL 50.68 mL

[ Pipet the components in the order they are listed in the table.
' Volumes include 10% overage.

IMPORTANT! Only make enough Mix for immediate use. Mix is not stable for prolonged periods
and will result in a reduction of DNA yield.

Add 480 pL of the Proteinase K Mix to each well containing a swab.

Be careful to avoid touching the pipette tip to the swab when pipetting the Proteinase K Mix into
the sample wells.

Seal the plate with the clear adhesive film, then shake the sealed plate at 900 rpm for 5 minutes.

Take the plate off the plate shaker, then immediately incubate at 65°C for =20 minutes.

IMPORTANT! Arrange plate in the incubator to allow adequate flow around the plate wells to
ensure that samples quickly reach and maintain the incubation temperature.

During the incubation, proceed to “Set up the instrument” on page 36 for automated purification using
the KingFisher™ Flex Magnetic Particle Processor.

Set up the instrument

1.

36

Ensure that the instrument is set up for processing with the proper magnetic head (96 deep-well)
for your application.

Ensure that the proper heat block (96 well standard, not deep-well) is installed for your application.

Ensure that the proper program (MagMAX_Ultra2_Direct__v2_FLEX) has been downloaded from
the product page and loaded onto the instrument.
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Isolate DNA from buccal swabs
Set up the processing plates

During the incubation at 65°C, set up the Wash, Elution, and Tip Comb Plates outside the instrument
according to the following table.

Plate ID Plate position Plate type Reagent Volume per well
Wash | Solution Plate 2 Deep Well Wash | Solution 1,000 pL
Wash Il Solution Plate 1 3 Deep Well Wash Il Solution 1,000 pL
Wash Il Solution Plate 2 4 Deep Well Wash Il Solution 500 pL
Elution Plate 5 Standard Elution Solution 50 pL
Tip Comb 6 Place a 96 Deep-well Tip Comb in a Standard Plate

Note: The plates will be loaded onto the instrument immediately after the Sample Plate has been
prepared.

Bind the gDNA

1. Prepare the DNA Binding Bead Mix according to the following table.

Component Volume per well Volume per platel'l (96 samples)
Binding Solution 400 pL 42.24 mL
DNA Binding Beads 40 pyL 4.22 mL
Total volume 440 pL 46.46 mL

' Volumes include 10% overage.
2. At the end of Proteinase K digestion, shake the sealed plate at 900 rpm for 2 minutes.

3. Transfer the lysates to the corresponding wells of a new deep-well plate (this will be called the
Sample Plate), then discard the buccal swabs.

To remove buccal swab from the

Procedure
lysate

1. Set a multi-channel pipettor to 480 L and transfer one
Transfer the lysate to a new plate. row at a time.
2. Ensure each well contains 420-480 pL after transfer.

4. Add 440 pL of DNA Binding Bead Mix to each sample.

Note: Remix Binding Bead Mix frequently during pipetting to ensure even distribution of beads to
all samples/wells. Mixture is viscous, pipet slowly to ensure that the correct amount is added.

IMPORTANT! Avoid creating bubbles during mixing and aliquoting.

5. Immediately process the plates on the KingFisher™ Flex Magnetic Particle Processor 96DW.
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Wash and elute the gDNA
1. Select the program MagMAX_Ultra2_Direct_v2_FLEX on the instrument.
2. Start the run, then load the prepared plates into position when prompted by the instrument.
3. At the end of the run, immediately remove the plates from the instrument.

4. Transfer the eluate to the final tube/plate of choice for final storage.

Note: If preferred, the elution plate may be used for final storage of the DNA.

The purified DNA is ready for immediate use. Alternatively, store the plate at -20°C for long-term
storage.
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Isolate DNA from whole blood

This section contains brief procedures. For detailed information, see MagMAX™ DNA Multi-Sample Ultra
Kit (whole blood) User Guide (Pub. No. MAN0O10294).

Sample collection and storage

Sample collection: Collect blood samples using proper venipuncture collection and handling
procedures in EDTA or sodium citrate anticoagulant tubes. Invert the tube to ensure thorough
mixing.

Note: Heparin is not recommended as an anti-coagulant since it can cause inhibition of PCR.

(Optional) Sample storage: Store samples between —80°C and -20°C. We recommend storing
samples in smaller volumes to prevent multiple freeze/thaw cycles.

Guidelines for whole blood preparation

If the whole blood is frozen prior to use, thaw the sample at 25-37°C in a water bath until it is
completely liquid, then place on ice until needed.

Perform all steps at room temperature (20-25°C) unless otherwise noted.
When mixing samples by pipetting up and down, avoid creating bubbles.

Cover the plate during the incubation and shaking steps to prevent spill-over and cross-
contamination. We recommend a new MicroAmp™ Clear Adhesive Film for each step of the
procedure.

If you use a plate shaker other than the recommended shaker, confirm the following items:
— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal shaker speeds allow
for thorough mixing without splashing.

Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To calculate volumes
for other sample numbers, refer to the per-well volume and add 5% overage.

If the DNA vyield is lower than expected, extend the Proteinase K digestion to 45 minutes.

Before first use of the kit

Prepare Wash Il Solution: Make 80% ethanol from 100% absolute ethanol and Nuclease-Free Water.

Before each use of the kit

Vortex DNA Binding Beads to fully resuspend the beads before each use.
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Set up the instrument

1. Ensure that the instrument is set up for processing with the proper magnetic head (96 deep-well)
for your application.

2. Ensure that the proper heat block (96 deep-well, not standard) is installed for your application.
3. Ensure that the proper program (MagMAX_Ultra2_200uL_v2_FLEX or

MagMAX_Ultra2_400uL_v2_FLEX) has been downloaded from the product page and loaded onto
the instrument.

Set up the processing plates

Set up the Wash, Elution, and Tip Comb Plates outside the instrument according to the following table.

Plate ID Plate position Plate type Reagent Volume per well
50-200 pL whole blood input
Wash | SolutionPlate 2 Deep Well Wash | Solution 500 pL
Wash Il Solution Plate 1 3 Deep Well Wash Il Solution 500 pL
Wash Il Solution Plate 2 4 Deep Well Wash Il Solution 500 pL
Elution Plate 5 Deep Well Elution Solution 50-100 pL
Tip Comb 6 Place a 96 Deep-well Tip Comb in a Standard Plate
200-400 pL whole blood input
Wash | SolutionPlate 2 Deep Well Wash | Solution 1,000 pL
Wash Il Solution Plate 1 3 Deep Well Wash Il Solution 1,000 pL
Wash Il Solution Plate 2 4 Deep Well Wash Il Solution 500 pL
Elution Plate 5 Deep Well Elution Solution 50-100 pL
Tip Comb 6 Place a 96 Deep-well Tip Comb in a Standard Plate

Note: The plates will be loaded onto the instrument immediately after the Sample Plate has been
prepared in the next section.
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Prepare Sample Plate and digest with Proteinase K

1. Transfer appropriate amount (according to the following table) of Enhancer Solution first, then
sample, and lastly Proteinase K, to the appropriate wells of a deep-well plate. This will be the
Sample Plate.

Enhancer Solution (uL) Sample Volume (uL) Proteinase K (uL)
5 50 5
10 100 10
20 200 20
30 300 30
40 400 40

Note:
. Do not pre-mix the Enhancer Solution and Proteinase K.

. Do not change the order of pipetting.

. Once all components are added, proceed immediately to the instrument processing. There is no
need for manual mixing beforehand.

2. Select the program on the instrument according to the following table.

Whole blood input volume Program
50-200 pL MagMAX_Ultra2_200uL_v2_FLEX
200-400 pL MagMAX_Ultra2_400pL_v2_FLEX

3. Start the run, and load the prepared plates into position when prompted by the instrument.

During this on board Proteinase K sample digestion (~20 minutes) prepare the DNA Binding Bead
Mix.

Purify the gDNA

1. Prepare DNA Binding Bead Mix according to the following table.

Component Volume per well Volume per platel']

50-200 pL whole blood input (96 samples per plate)

Binding Solution 200 pL 21.12mL
DNA Binding Beads 20 pL 211 mL
Total volume 220 pL 23.23 mL

200-400 pL whole blood input (96 samples per plate)

Binding Solution 400 pL 42.24 mL
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(continued)

Component Volume per well Volume per platel!!
DNA Binding Beads 40 L 4.22 mL
Total volume 440 uL 46.46 mL

[ Volumes include 10% overage.

2. When instructed by the instrument (~20 minutes after the run has started), remove the Sample
Plate and add DNA Binding Bead Mix to each sample, according to the following table.

For whole blood input volume Add DNA Binding Bead Mix
50-200 pL 220 pL
200-400 pL 440 pL

Note: Remix Binding Bead Mix frequently during pipetting to ensure even distribution of beads to
all samples/wells. Mixture is viscous, pipet slowly to ensure that the correct amount is added.

IMPORTANT! Avoid creating bubbles during mixing and aliquoting.

3. Immediately place the plate back onto the KingFisher™ Flex and follow the prompts on the
instrument to allow the sample processing to proceed.

4. At the end of the run, immediately remove the plate from the instrument and transfer the eluate to
the final tube/plate of choice for final storage.

The purified DNA is ready for immediate use. Alternatively, store the plate at -20°C for long-term
storage.

Prepare a DNA stock solution for OpenArray™ experiments

The recommended input for OpenArray™ plates is 825 pg of DNA per 33-nL reaction.

1. Quantify DNA by any of the following methods. Before quantifying, mix the samples well to ensure
sample homogeneity, especially if samples have been stored.

* RNase P C; value method (recommended)—See Appendix C, “RNase P quantification for
genotyping experiments”.

¢ UV absorbance measurements —Use a NanoDrop™ or other comparable instrument. The
Aogo/Asgp ratio of high-quality gDNA is 1.8-2.0.

* Fluorometric analysis—Use a Qubit™ dsDNA BR or HS Assay Kit.

2. Prepare a 50 ng/uL DNA stock solution to use in the PCR setup.

Samples with low concentration (<10 ng/pL) and/or low quality may require preamplification. See
Appendix B, “Preamplification of low-concentration gDNA”.
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Normalize DNA samples for copy number analysis

The required input for each 10-uL PCR is 10 ng of DNA.

Run each sample in quadruplicate for each copy number assay.

1. Dilute a portion of each gDNA sample to 5 ng/pL. Prepare sufficient DNA for the required number
of reactions.
(# of assays) x (Vol. of 5 ng/uL DNA per 10 pL reaction) x (# of replicates) x 120% (for dead
volume)
For example, if you are running 5 copy number assays, prepare at least:
(5 Assays) x (2 uL) x (4 replicates) x 120%
= 48 pL of each sample at a concentration of 5 ng/puL

2. Store the diluted samples at 4°C for immediate use or at —25°C to -15°C for long-term storage.
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Prepare and run OpenArray™ PGx
SNP genotyping experiments

B O OrK I OW ..o e e 45
B Required materials for the OpenArray™ Plate workflow ........... ... ... 47
m Recommended: Run OpenArray™ SNP genotyping experiments in real-time mode ........... 49
B Prepare the OpenArray™ Plates with OpenArray™ AccuFill™ Software v1.2 .................. 51
B Prepare the OpenArray™ Plates with OpenArray™ AccuFill™ Software v2.0 .................. 58
B Seal and run the OpenArray™ Plates . ... .......iiutire i 67
This chapter contains brief procedures. For detailed procedures, see the following documents:
Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
OpenArray™ Sample Tracker Software Quick Reference, for OpenArray™ AccuFill™ Software
V1o 4460657
OpenArray™ AccufFill™ System User Guide, for OpenArray™ AccuFill™ Software v1.2 4456986
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide, for OpenArray™ AccuFill™ MANO0025669
Software v2.0
OpenArray™ SNP Genotyping Experiments MANO0014351
TagMan™ OpenArray™ Genotyping Troubleshooting Guide MANO0011115
TagMan™ Genotyper Software Getting Started Guide 4448637
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Workflow

Option 1: OpenArray™ AccuFill™ Software v1.2

Generate 384-well sample plate layouts in the OpenArray™ Sample
Tracker Software

(page 53)

v

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate
(page 54)
\ 4

Set up the OpenArray™ AccuFill™ Instrument and the OpenArray™
AccuFill™" Software
(page 55)

\4

Transfer reactions to the OpenArray™ Plate using the OpenArray™
AccuFill™ Instrument

(page 56)

v

Seal and run the OpenArray™ Plates
(page 67)
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Option 2: OpenArray™ AccuFill™ Software v2.0

Download SPF files
(page 58)
v

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate
(page 59)

v

Set up and start the run

v

Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument
(page 64)
v

Seal and run the OpenArray™ Plates
(page 67)
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Required materials for the OpenArray™ Plate workflow

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

Item Source
Instruments, software, and equipment
OpenArray™ Sample Tracker Software .
(Not required for OpenArray™ AccuFill™ Software v2.0)
QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 A24945
QuantStudio™ 12K Flex Real-Time PCR System with OpenArray™ block 4471090
(QuantStudio™ 12K Flex OpenArray™ AccuFill™ System)
Centrifuge, capable of spinning sample plates at 1,200 x g MLS
Plates and accessories
OpenArray™ 384-well Sample Plates, black
4482221
or
4406947
OpenArray™ 384-well Sample Plates, clear
. . - Beckman
(Optional) Biomek™ Seal and Sample Foil Lids Coulter™
(for pre-plating step) 538619
OpenArray™ AccuFill™ System Tips 4458107
QuantStudio™ 12K Flex OpenArray™ Accessories Kitl?] 4469576
Forceps MLS
A sharp edge, blade, or scalpel (to cut the adhesive foil) MLS
A fine-tip silver or gold marker for black OpenArray™ 384-well Sample Plates MLS
A fine-tip black marker for clear OpenArray™ 384-well Sample Plates
Reagents
Genomic DNA See Chapter 3
on page 32
OpenArray™ Plates with PGx assays 4488847
TagMan™ OpenArray™ Genotyping Master Mix 4404846
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(continued)
Item Source
100% molecular grade ethanol MLS
Nuclease-free water 4387936

0 Included with the QuantStudio™ 12K Flex Software.
[l Each kit contains the items needed to assemble up to 10 plates: 12 lids and plugs, 12 immersion fluid syringes, and 2 carriers. Each

custom OpenArray™ Plate order is shipped with accessories kits.
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Recommended: Run OpenArray™ SNP genotyping
experiments in real-time mode

We recommend running all OpenArray™ plates on a QuantStudio™ instrument in real-time experiment
mode. This recommendation allows observation of genotyping data over time to evaluate the accuracy
of genotype calls by observing the location of a given sample relative to others throughout all cycles.

The following example shows how calls based on end-point reads could be incorrect when the DNA
concentration is higher than the recommended amount.

Without traces With real-time traces
s ,. - .y "
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Left: Calls based on end-point reads could be incorrect. Right: Real-time genotyping graphs used for making accurate calls when
using samples with very high DNA concentration. Red: homozygous Allele 1/Allele 1. Blue: homozygous Allele 2/Allele 2. Green:
heterozygous Allele 1/Allele 2.

Note: Generally, a Ct value of ~25 indicates that the sample input is approximately 250 haploid copies,
which is the recommended input amount per 33-nL reaction. This corresponds to 825 pg of DNA per
PCR reaction using a stock solution of 50 ng/pL.

The default run type for genotyping experiments is real-time mode, indicated by the selection of Include
Amplification in the Setup OpenArray Run window. The default settings also include the selection of
Include Pre-read; this setting is strongly recommended to correct for background fluorescence on the
plate.
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Run Opendrray.

Load the reaction plate into the instrument. Select the instrument and enter the setup files, then click Start Run.

© K

LT

Select Instrument

|
&
‘v%

FOSHAYASHK1LO4
READY

Setup OpenArray Run

[ Get Plate IDs ] [ Confirm Plate Centers ] Run Type : Genotyping | [+] Include Amplification [#] Include Pre-read

Reagent Type : TagMan

Opendrray 1 DEBOL | *SetupFie: | loaded_DEBO1.spf || Brawse | * Experiment File Location @ |lex Software\User Filas\Experiments [ Browse ]

Sarnple File : [ Browise ] * Experiment File Marme ©  |DEBD1_2012_03_05_124756.eds

* Setup File @ I:I * Experiment File Location

* Experiment File Mame

|:| * Setup File : I:I * Experiment File Location

Opendrray 3

* Experiment File Mame

Opendrray 2 @

Opendrray 4

* Setup File : I:I * Experiment File Location

* Experiment File Mame :

For additional information about genotyping experiments, see the QuantStudio™ 12K Flex Real-Time
PCR System: OpenArray™ Experiments User Guide (Pub. No. 4470935).
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i

Prepare the OpenArray™ Plates with OpenArray™ AccuFill™
Software v1.2

For required materials, see “Required materials for the OpenArray™ Plate workflow” on page 47.

For instructions for OpenArray™ AccuFill™ Software v2.0, see “Prepare the OpenArray™ Plates with
OpenArray™ AccuFill™ Software v2.0” on page 58.

This chapter contains brief procedures. For detailed procedures, see the following documentation.

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ AccufFill™ System User Guide 4456986

One-time procedures

Set up default folders and software preferences

This procedure simplifies the file locations used in the OpenArray™ AccuFill™ Software.

Set up the default file locations and preferences before using the QuantStudio™ 12K Flex OpenArray™
AccuFill™ System for the first time.

1. Create the following four folders in a convenient location on the same computer drive as the
OpenArray™ AccuFill™ Software:

SPF Files

Sample Tracker 96-well Input
Sample Tracker 384-well CSV Files
Loaded SPF Files

2. (Optional) Copy a template file into the OpenArray™ Sample Tracker Software folder.

Navigate to this folder on your computer: <..>\Program Files (x86) \Applied
Biosystems\OpenArray Sample Tracker\examples, where <...> is the drive.

Copy the 96-Well Sample Plate 1.csv template file, which is provided with the
OpenArray™ Sample Tracker Software.

Paste the template file into the Sample Tracker 96-well Input folder.
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3. In the OpenArray™ Sample Tracker Software, select View » Preferences, then enter the following

preferences:
Field Selection
Experiment type Genotyping
OpenArray™ Plate Select the OpenArray™ format that will be run most often; for example,
Genotyping - 64
Pipettor Fixed or Adjustable tip spacing
Import Data Directory | Sample Tracker 96-well Input
Export Data Directory | Sample Tracker 384-well CSV Files

4. Inthe OpenArray™ AccuFill™ Software, select Instrument » Edit Preferences » Require Sample
Integration, then select the folders indicated in this table:

OpenArray™ AccuFill™ Software

Default folder Folder contents
folder
OpenArray Plate File SPF Files SPF files for the OpenArray™ Plates, with
Input Folder assay name and location
Sample Plate File Sample Tracker CSV 384-well sample plate layout files
Folder 384-well CSV
Files

Loaded OpenArray Plate |Loaded SPF Files |Integrated SPF files generated during
File Folder processing with the OpenArray™ AccuFill™
Software.

5. In the QuantStudio™ 12K Flex Software, select Tools » Preferences » OpenArray, then select the
Loaded SPF Files folder for the software Setup Folder.

Note: If the QuantStudio™ 12K Flex Software is not on the same computer as the OpenArray™
AccuFill™ Software, transfer the loaded SPF files to the computer running the QuantStudio™ 12K
Flex Software.

Download SPF files

Set up the optimized folder locations and software preferences before downloading SPF files. See “Set
up default folders and software preferences” on page 51.

To download SPF files for custom OpenArray™ Plates, you need the Lot# and the Serial# from the
packaging of each OpenArray™ Plate.

1. Go to thermofisher.com/OA-platefiles.

2. From the Select Your Product dropdown list, select TagMan™ OpenArray™ Custom Gene
Expression/Genotyping Plates.

3. Select the desired option for downloading either only the SPF files or both the SPF files and the
AIF files.
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4. Enter the Lot# and the Serial#, then click Submit.

Note: The Serial# is case-sensitive.

5. Save the SPF files to the desktop SPF Files folder.

Note: Do not create sub-folders in the SPF Files folder. The software cannot access sub-folders.

Generate 384-well sample plate layouts in the OpenArray™ Sample Tracker
Software

Before generating 384-well sample plate layouts, see “One-time procedures” on page 51 to complete
the following tasks:

* Set up optimized folder locations and software preferences.
* Download the SPF files for the OpenArray™ Plates into the SPF Files folder.

1. Using a spreadsheet program, create a 96-well sample CSV file.

a. Navigate to the following folder, then open the 96-Well Sample Plate 1.csvtemplate
that is provided with the OpenArray™ Sample Tracker Software.

<.>\Program Files (x86)\Applied Biosystems\OpenArray Sample
Tracker\examples, where <...> is the drive.

b. Save As the template as a new 96-well sample CSV file. Save your 96-well sample CSV file in
the Sample Tracker 96-well Input folder.

c. Enter or copy the sample names into your 96-well sample CSV file.
2. Open the OpenArray™ Sample Tracker Software.

3. In the Properties screen, select Genotyping for Experiment Type, then select the appropriate
settings for OpenArray™ Plate and Pipettor.

4. Inthe Samples screen, click £ Import, then select and import your 96-well sample CSV file that
you created in step 1.

5. In the Sample Mapping screen, confirm that the samples for a single OpenArray™ Plate are
assigned to one color.

Note: If necessary, correct the OpenArray™ Plate and Pipettor settings in the Properties screen.

6. In the Sample Mapping screen, click the 384-Well Plate tab, then click Export » Export *.csv.
7. Select 384-Well Plate (for AccufFill), enter a file name, then save the exported file.

Plate layouts for the 384-well sample plates are saved to individual CSV files in the Sample Tracker
384-well CSV Files folder.
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Set up the PCR reactions in an OpenArray™ 384-well Sample Plate

IMPORTANT! The 4 x 12 areas of the OpenArray™ 384-well Sample Plate being filled must match the
areas designated in the OpenArray™ Sample Tracker Software for that set of samples.

1. Remove an OpenArray™ Plate from the freezer and set it aside. Allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ Plate must be completely thawed before transferring reactions to it from the
OpenArray™ 384-well Sample Plate created in this section.

2. Gently swirl the contents of the TagMan™ OpenArray™ Genotyping Master Mix to thoroughly mix.
Do not invert the bottle.

3. Following the plate layout designated in the OpenArray™ Sample Tracker Software, add master
mix, then UltraPure™ DNase/RNase-Free Distilled Water (NTCs) or DNA samples, to an OpenArray™
384-well Sample Plate.

OpenArray™ Plate Format

Component 16 32 64+

Volume per well

TagMan™ OpenArray™ Genotyping Master Mix 1.5 L 2.0 L 25 L
One of the following:
* UltraPure™ DNase/RNase-Free Distilled Water (NTCs) 1.5 uL 2.0 L 2.5 L
* DNA sample
Total reaction volume 3.0 uL 4.0 uL 5.0 uL

4. Thoroughly mix each PCR reaction by pipetting up and down or by using the "mix" function
on a multi-channel pipette. Alternatively, vortex the OpenArray™ 384-well Sample Plate for 10-15
seconds after sealing with aluminum foil in step 5.

5. Seal the OpenArray™ 384-well Sample Plate with an aluminum foil seal, remove the foil flap, then
mark the edges of the filled 4 x 12 area with a pen.

6. Vortex the plate for 20-30 seconds, then centrifuge the plate at 1,200 x g for 1 minute.

7. Score the foil along the lines that were marked before centrifuging.
Do not remove the foil from the scored area at this time.

If you make a sample layout error before the AccuFill™ procedure — Repeat “Generate 384-well sample
plate layouts in the OpenArray™ Sample Tracker Software” on page 53 with a corrected 96-well sample
CSV file.
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Set up the OpenArray™ AccuFill™ Instrument and the OpenArray™ AccuFill™
Software

IMPORTANT! Do not use OpenArray™ AccuFill™ System Tips that exceed the expiration date (shown
on the outer box that contains the tip trays).

1. In the OpenArray™ AccuFill™ Software, click Setup and Load.
The Setup Load Information window appears.

Setup Load Information

Loading information

Specify the type of load you want to perform. Enter Plate and OpenArray® Plate barcodes by
scanning them, typing them, or selecting the associated file

@— [¥] Use Sample Integration D Force Single Sample Loading
Sample Plate f @ Plate Holder Position 1 @
@ | Plate Holder Position 2 [Browse._ |
Plate Holder Position 3 _©
Plate Holder Position 4 [@

Select Samples to Load

Click the section on the sample plate from which the first sample will be extracted. The image on
the right shows how the sample will be applied to the OpenArray Plates._

T TIIT _Plate Holder Position 1
$ +
+ &

Plate Holder Position 2

late Holder Position 3

late Holder Position 4

TN RO T

f

Cancel

@ Use Sample Integration checkbox; select to integrate SPF files and the 384-well sample plate CSV file.

@ Browse button; click to locate and select the 384-well sample plate CSV file. The button is displayed only if
Use Sample Integration is selected.

@ Browse buttons; click to locate and select the SPF files for the OpenArray™ Plates that will be placed in the
corresponding Plate Holder Position on the deck of the OpenArray™ AccuFill™ Instrument. The buttons are
displayed only if Use Sample Integration is selected.

@ Plate Holder Position corresponding to the position of the OpenArray™ Plate on the deck of the instrument.

2. Configure the Loading Information pane for sample integration using the 384-well sample plate
CSV file and SPF files.

a. In the Loading Information pane (top section of the window), ensure that the Use Sample
Integration checkbox is selected.

b. Click Browse to the right of the Sample Plate field, then select the 384-well sample plate
CSV file that you generated with the OpenArray™ Sample Tracker Software in the Sample
Tracker 384-well CSV Files folder.

c. Click Browse to the right of the Plate Holder Position of the OpenArray™ Plate, then select
the SPF file for the OpenArray™ Plate in the SPF Files folder.
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3. In the Select Samples to Load pane (bottom section of the window), click the corresponding
4 x 12 area of the 384-well sample plate image, then click Next.

The Setup Deck window is displayed.

4. In the OpenArray™ AccuFill™ Instrument, ensure that:
* Tip boxes and tips are loaded as shown in the Setup Deck window.
* The lids are removed from the tip boxes.
¢ The waste bin in the instrument is emptied.

5. In the Setup Deck window, confirm that the deck is ready:
* Select The tips are configured as shown above.
* Select The Waste Bin is empty.

Transfer reactions to the OpenArray™ Plate using the OpenArray™ AccuFill™
Instrument

IMPORTANT! Ensure that the OpenArray™ Plate is thawed and that the entire plate is at room
temperature.

1. Prepare the items needed to seal the loaded OpenArray™ Plate (next section).

Note: The OpenArray™ Plate must be sealed promptly after being loaded with the reactions, as
described here.

* Ensure that the QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 is ready.

¢ Gather and remove from their packaging the following: an OpenArray™ Lid, plug, syringe with
OpenArray™ Immersion Fluid, and syringe tip.

* Attach the syringe tip to the syringe, carefully push some of the fluid through the tip to remove
air bubbles, then lay the syringe aside.

2. Load the OpenArray™ Plate and the OpenArray™ 384-well Sample Plate into the OpenArray™
AccuFill™ Instrument.

* OpenArray™ Plate —Remove the plate from its sleeve, then place the plate in the appropriate
plate holder position in the instrument.

Ensure that the barcode on the OpenArray™ Plate is facing left and the serial number is facing
right.

* OpenArray™ 384-well Sample Plate —Place the 384-well sample plate onto the deck of the
instrument, then use forceps to peel the foil from the filled area of the plate.

3. Close the door of the instrument.

4. Inthe OpenArray™ AccuFill™ Software Setup Deck window, select the following confirmations:
* The OpenArray Plate is in the Plate Holder
* Remove foil from the highlighted section of the Sample Plate

5. Click Load.
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6. As soon as the Remove OpenArray Plate window appears, open the instrument door, then
remove the loaded OpenArray™ Plate.

7. Proceed immediately to seal the OpenArray™ Plate.
See “Seal the OpenArray™ Plate” on page 67.

Note: For best results, seal the OpenArray™ Plate within 90 seconds of completion of loading to
prevent evaporation.
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Prepare the OpenArray™ Plates with OpenArray™ AccuFill™
Software v2.0

For required materials, see “Required materials for the OpenArray™ Plate workflow” on page 47.

For instructions for OpenArray™ AccuFill™ Software v1.2, see “Prepare the OpenArray™ Plates with
OpenArray™ AccuFill™ Software v1.2” on page 51.

This chapter describes the full run workflow. For other workflow options, see the following
documentation.

This chapter contains brief procedures. For detailed procedures, see the following documentation.

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide MANO0025669
gg;eefz;;a;ﬂ” AccufFill™ Software v2.0 Quick Run Workflow Without Sample Information Quick MANO0025835
OpenArray™ AccufFill™ Software v2.0 Full Run Workflow Quick Reference MANO0025836

Download SPF files
The computer with the OpenArray™ AccuFill™ Software v2.0 must be connected to the internet.

1. In the TPF/SPF screen, select the Download radio button.

2. Select the product.

* TagMan OpenArray Custom
* TaqMan OpenArray Inventoried

3. Enter the following information.

Product Information
'(I;aqun a. Enter the Lot number or Batch number.
penArray .

Custom b. Enter one Serial number from the lot.
Note: Only one serial number is required. The serial number is used to confirm the
lot number or batch number. All of the files in the lot or batch are downloaded.

TagMan Enter the list of Serial numbers or Barcodes. Separate more than one serial

OpenArray number or barcode with a comma or a line break.

Inventoried

Note: The serial number or barcode entered corresponds to the file that is
downloaded. Enter a serial number or barcode for each file to download.
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Note: The fields that are displayed depend on the product selected in step 2.

4. Click Download.

The location of the files is displayed at the top of the screen. The location of the downloaded files

is set in the Preferences menu, in the OpenArray plate file folder field. See QuantStudio™ 12K Flex
OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669) for more information about setting
the preferences.

The files are in a compressed ZIP folder.

a & B wm = % O
Preferences Service Help

QuickRun  Full Run MapPlates  TPF/SPF  Folders

® Download successfully saved to D:\OpenArray\OpenArrayPlates\2577466.zip Open folder X

Click Open folder to access the files or click X (Close) to close the message.

Extract the files from the compressed ZIP folder.

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate

IMPORTANT! The 4 x 12 areas of the OpenArray™ 384-well Sample Plate being filled must match the
areas designated in the OpenArray™ AccuFill™ Software for that set of samples.

1. Remove an OpenArray™ Plate from the freezer and set it aside. Allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ Plate must be completely thawed before transferring reactions to it from the
OpenArray™ 384-well Sample Plate created in this section.

2. Gently swirl the contents of the TagMan™ OpenArray™ Genotyping Master Mix to thoroughly mix.
Do not invert the bottle.

3. Following the plate layout designated in the OpenArray™ Sample Tracker Software, add master
mix, then UltraPure™ DNase/RNase-Free Distilled Water (NTCs) or DNA samples, to an OpenArray™
384-well Sample Plate.

OpenArray™ Plate Format

Component 16 32 64+

Volume per well

TagMan™ OpenArray™ Genotyping Master Mix 1.5 L 2.0 L 25uL
One of the following:
¢ UltraPure™ DNase/RNase-Free Distilled Water (NTCs) 1.5 L 2.0pL 2.5 L
* DNA sample
Total reaction volume 3.0puL 4.0 yL 5.0 uL
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4. Thoroughly mix each PCR reaction by pipetting up and down or by using the "mix" function
on a multi-channel pipette. Alternatively, vortex the OpenArray™ 384-well Sample Plate for 10-15
seconds after sealing with aluminum foil in step 5.

5. Seal the OpenArray™ 384-well Sample Plate with an aluminum foil seal, remove the foil flap, then
mark the edges of the filled 4 x 12 area with a pen.

6. Vortex the plate for 20-30 seconds, then centrifuge the plate at 1,200 x g for 1 minute.

7. Score the foil along the lines that were marked before centrifuging.
Do not remove the foil from the scored area at this time.

If you make a sample layout error, it is possible to correct this in the OpenArray™ AccuFill™ Software
using the plate rotation feature. For more information, see QuantStudio™ 12K Flex OpenArray™ AccuFill™
System User Guide (Pub. No. MAN0025669).

Set up and start the run

Before you begin—full run workflow

* Prepare samples in a 384-well plate (see “Set up the PCR reactions in an OpenArray™ 384-well
Sample Plate” on page 59).

* Place the sample plate in the sample plate holder on the instrument deck, with the notch to the left.
Do not stack sample plates.

* Load the tip boxes, then remove the tip box covers.
Do not stack the tip boxes.

* Place the OpenArray™ Plates in the plate holders.
® (Clear the instrument deck, empty and replace the waste bin, then close the instrument door.
¢ Allow the instrument to perform a self-test if the run is being started after the software is launched.

* Prepare the materials in the QuantStudio™ 12K Flex OpenArray™ Accessories Kit
These materials are used to seal the OpenArray™ Plates.

IMPORTANT! OpenArray™ Plates must be sealed immediately after loading.

Configure the experiment design for the full run workflow
A SPF file is required for this workflow.

Navigate to the Full Run screen.

1. In the Configure design pane, in the Experiment type section, select Genotyping.

2. In the Plate format section, select a format.
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3. If the Pipettor section is displayed, select a type of pipette.
* Fixed

¢ Adjustable

4. Inthe Add your OpenArray Plate serial numbers section, click Choose File, navigate to the
location of the SPF file, then select the file.

Repeat for each SPF file.

5. In the Add your sample plates - optional section, click Choose File, navigate to the location of
the CSV file, then select the file.

The format of the sample plate file is validated. For information about the required format, see the
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669).

The name of the file is displayed in the Select file field.
6. Repeat step 5 for each CSV file.
7. Click Next.

The Map plates pane is displayed.

Proceed to “Add or edit sample names” on page 61.

Add or edit sample names
If needed, navigate to the Map plates pane in the Full Run screen.

If a sample plate file was imported, the sample names are displayed. The sample plate layout defined in
the sample plate file can be edited.

If the sample plate file was not imported, the samples must be added manually.

1. Add or edit the sample name.
2. Click Next.
Proceed to “Verify the run setup and start the run” on page 61.

Verify the run setup and start the run

1. Click each tip box section so that the status on the Verify and start run pane matches the
physical tip box in the instrument.
We recommend starting the run with full tip boxes.
The instrument does not start the run if there are not enough tips on the deck.
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Update the state of the tip boxes

T

9000000000080
OO XX XX X )

eesesscenes
00000000005 0000000000800
000000000000 000000000000

(1) Section of the tip box that is full
@ Section of the tip box that is empty

. (Optional) Click Auto-fill tip boxes.

The status of all section of the tips boxes is set to full.

- Select the first section of the sample plate that will be used to fill the OpenArray™ Plate.

Select the first section of the sample plate if multiple OpenArray™ Plates are filled during a run. The
software selects the total number of sections that correspond with the total number of OpenArray™
Plates.

In the following example, section 5 was selected. The group of sections 5, 6, 7, and 8 is highlighted
by the software because four OpenArray™ Plates are being filled.

The position box displays the color that corresponds to the section of the sample plate.

Select the sample platelarea to begin OpenArray plate name and position

| iemmemmeass EX == 2 BN Fre74
AEEEEEEEEEEE Em L ] |
- FTB75
SN T
EENEEEEEEEEEE EEEEN EEER IIEII F113:76

FTB77

@ Sample plate section (section 5, 6, 7, and 8 are highlighted)
@ Corresponding OpenArray™ Plates

Remove the foil from the appropriate sections of the sample plate, then click the checkbox to
confirm.

Remove the foil only from the sections of the sample plate that are used to load a single
OpenArray™ Plate.

Note: Do not remove the foil from all the sections of the sample plate at once.

5. Close the instrument door.
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6. Click Start Run.
The run does not begin under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The OpenArray™ Plates are not in position

* There are more OpenArray™ Plates on the instrument deck than are defined in the experiment
setup

The Deck screen is displayed.

For a description of the run progress, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User
Guide (Pub. No. MAN0025669).

IMPORTANT! Each OpenArray™ Plate must be prepared for PCR immediately after it is filled (see
“Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument” on page 64).
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Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument

After an OpenArray™ Plate is filled, the Remove plate and foil dialog box is displayed (see Figure 1 on
page 64).

Remove each OpenArray™ Plate immediately after it has been filled, even if the run was set up to fill
multiple plates.

After the last OpenArray™ Plate in the run is filled, the Remove plate dialog box is displayed (see
Figure 2 on page 65).

Remove plate & foil X
Step 1 Step 2
Remove OpenArray Plate 1 and promptly seal the plate Confirm foil is removed from highlighted plate

with the adhesive lid, and fill with immersion fluid.

== |

]
E
3

EEE n 4
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=

Figure 1 Remove plate and foil dialog box

@ OpenArray™ Plate to remove from the instrument
@ Confirm foil is removed from highlighted plate section checkbox
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Remove plate X

Remove OpenArray Plate 2 and promptly seal the plate with
the adhesive lid, and fill with immersion fluid.

Figure 2 Remove plate dialog box

@ OpenArray™ Plate to remove from the instrument

1. Open the instrument door and remove the OpenArray™ Plate that is indicated by the blue box in
the dialog box.

IMPORTANT! Remove the OpenArray™ Plate immediately, to avoid evaporation within the plate.

One of the following dialog boxes is displayed:
* The Remove plate and foil dialog box.
* The Remove plate dialog box (after the last OpenArray™ Plate is filled).

2. Seal the case and fill the OpenArray™ Plate with immersion fluid.
See “Seal the OpenArray™ Plate” on page 67.

3. (For Remove plate and foil dialog box only) Remove the foil seal from the next section of the
sample plate, then select the checkbox to confirm that the foil is removed from the section of the
plate that is highlighted.

Note: Remove the foil only from the next section of the sample plate. Do not remove the foil from
all sections of the sample plate.

4. Close the instrument door.
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5. Click Done.
The run does not proceed under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The OpenArray™ Plates are not in position
* There are more OpenArray™ Plates on the instrument deck than are defined in the experiment
setup

The instrument will proceed to load the next OpenArray™ Plate.
6. Repeat step 1 to step 5 for each OpenArray™ Plate to be loaded.
After all of the OpenArray™ Plates have been loaded, the Deck screen displays Run completed

successfully. Empty the waste bin before performing another run.

A loaded SPF is generated for each OpenArray™ Plate. The loaded SPF file corresponds to the original
SPF file that was imported for the run. The files are exported to the folder that was designed in the
Preferences.

Note: Some workflows might not generate a loaded SPF file. For more information about the workflows
available for the OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex OpenArray™
AccuFill™ System User Guide (Pub. No. MAN0025669).
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Seal and run the OpenArray™ Plates

Seal the OpenArray™ Plate

IMPORTANT! Throughout this procedure, handle the OpenArray™ Plate and the OpenArray™ Case only
by the edges.

Note: The OpenArray™ Case consists of the sealed OpenArray™ Plate and the OpenArray™ Lid.

1. Place the newly loaded OpenArray™ Plate in the QuantStudio™ 12K Flex OpenArray™ Plate
Press 2.0.

Ensure that the barcode is facing left and the serial number is facing right.

2. From the OpenArray™ Lid, remove the clear protective film from the inside of the lid D and the red
adhesive-protective strip @ from around the edge of the lid.

o2 6

Figure 3 OpenArray™ Lid

@ Protective film on inside of the lid (remove before sealing)

@ Red adhesive-protective strip (remove before sealing)

@ Protective film on the outside of the lid (remove before running)
@ Notched end (align with serial number on plate)
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3. Place the lid in the Plate Press using the alignment pins of the Plate Press for orientation.

IMPORTANT! The notched end of the case lid must be oriented towards the furthest back
right-side of the Plate Press.

@ OpenArray™ case lid
(@ Notched end of lid
@ Serial number of plate
@ OpenArray™ Plate

@ Barcode of plate

(® Alignment pins

4. Seat the lid on the OpenArray™ Plate with the lid adhesive against the plate.

5. Engage the press mechanism until the green flashing light changes to a steady green light (after
20 seconds).

The status light turns solid green, indicating that the case is sealed.

Note: Do not apply additional pressure onto the Plate Press during its actuation.

6. Disengage the press and carefully remove the OpenArray™ Case.

7. Prepare the immersion fluid. Remove the cap, insert the accompanying syringe tip, and prime the
syringe by ejecting a small amount of immersion fluid onto a paper towel to ensure no air gap
remains in the newly attached pipette tip.

IMPORTANT! If the syringe is not primed, the direct burst of air and fluid can negatively affect the
assay(s) at the end of the array.
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A

8. While holding the case upright by its edges at a 15-30 degree angle so that the port is at the
highest point of the array, insert the prepared syringe tip into the port in the case.

The syringe tip must be in front of the array when filling the case with immersion fluid.

9. Slowly inject the OpenArray™ Immersion Fluid until the case is filled, which should take about 10
seconds to fill. Minimize the creation of additional air bubbles when you dispense the fluid. Leave a
small air bubble as shown below.

IMPORTANT! If injected too quickly, the fluid can flush out the samples that are suspended in the
through-holes.

Overfilling the array and/or not leaving a small bubble may cause a leak during the PCR run.
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10. While holding the case vertically, remove the syringe tip, insert the screw end of the OpenArray™
plug into the port of the case, then rotate clockwise until the black handle breaks off.

Note: Ensure that you are screwing the plug in at the same angle the case base is at. If it is off, it
can cause the plug to break off prematurely.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and rotate the plug
slowly to avoid cross-threading.

If the plug handle breaks off prematurely, use a Phillips #0 screwdriver to complete this step. Do
not overtighten. If plastic or adhesive remains attached to the screw due to premature breakout of
the plug handle, remove it with forceps prior to loading it into the instrument.

11. If needed, clean the case with the lint-free cloth included with the OpenArray™ Plate or a laboratory
wipe that has been thoroughly sprayed with ethanol, then dry the case with a clean laboratory
wipe.

Run the OpenArray™ Plate on the QuantStudio™ 12K Flex Real-Time PCR
System

You can run up to four OpenArray™ Plates at one time on the QuantStudio™ 12K Flex Real-Time PCR
System.

1. On the QuantStudio™ 12K Flex Real-Time PCR System touchscreen, touch [ to extend the
instrument tray arm.

2. Remove the clear protective film from the outside of the OpenArray™ case (sealed plate + lid).

3. Place the OpenArray™ case on the tray arm plate adapter.

* Support the case from underneath the tray arm to prevent the case from slipping through the
adapter.

* Ensure that the plate barcode and serial number are facing the front of the instrument.

¢ Ensure that the OpenArray™ Plate adapter A1 position is aligned with the instrument arm
adapter A1 position.

4. Touch [ to retract the instrument tray arm.
5. Inthe ﬁ Home screen of the QuantStudio™ 12K Flex Software, in the Run pane, click OpenArray.
6. In the Select Instrument pane, select your instrument.

7. Click Get Plate IDs to import the barcode of the OpenArray™ Plate.

Once the OpenArray™ serial number appears, the loaded SPF file corresponding to the plate
should appear in the Setup File field.

If the SPF file does not appear, click Browse, then select the correct loaded SPF file from the
Loaded SPF folder.

8. (Optional) Click Browse to change the Experiment File Location.

9. (Optional) Change the software-determined Experiment File Name.
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Click Start Run.

Note: The instrument pauses prior to the end of the run. Wait for the system to complete the run
before opening the EDS file.

Transfer the EDS file from the instrument to an accessible location for analysis.

Check the QC images for loading issues or leaks.

Check the quality—control images

Check the quality—control (QC) images before analysis. Images can be viewed using Imaged, an open—
source software available from the NIH at imagej.nih.gov/ig.

1.

In the QuantStudio™ 12K Flex Software E Export screen, click Browse, then create a uniquely-
named folder for the QC images export.

IMPORTANT! Create a new folder for images each time. Exporting a second run to the same
folder overwrites the images.

Click Export QC Images at the bottom of the screen.

View the following ROX™ image to check for loading quality issues:
¢ POST-READ_CHANNEL_A4.tiff

Check the following spotfinding images for leaks or other displaced sample issues.
* s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiff
* s02_c040_t03_p0001_m1_x2_el1_cp#_spotfind.tiff

Note: The “cp#” in the image file name refers to array positions 1 through 4 within the instrument.

If a problem is found, view the following pre-run spotfinding image to determine whether the issue
existed before cycling:

¢ s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiff

View the following FAM™ images to check for fluorescent abnormalities and to confirm any
problem seen in the spotfinding images:

* STAGE2_CYCLE1_CHANNEL_1.tiff
* STAGE2_CYCLE40_CHANNEL_1.tiff

Note any abnormalities found, as well as all other potentially relevant information related to the
setup of the run.
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This chapter contains brief procedures. For detailed procedures, refer to:

Title Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ AccufFill™ System User Guide 4456986
OpenArray™ SNP Genotyping Experiments MANO0014351
TagMan™ OpenArray™ Genotyping Troubleshooting Guide MANO0011115
TagMan™ Genotyper Software Getting Started Guide 4448637
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Workflow

Option 1: OpenArray™ AccuFill™ Software v1.2

Download SPF files
(page 76)

Create an array-specific template (EDT) file
(page 76)

Generate OpenArray™ Plate layouts in the OpenArray™ Sample Tracker
Software
(page 77)

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate
(page 78)

Set up the OpenArray™ AccuFill™ Instrument and the OpenArray™
AccuFill™ Software
(page 79)

Transfer reactions to the OpenArray™ Plate using the OpenArray™
AccuFill™ Instrument
(page 80)

Seal and run the OpenArray™ Plates
(page 91)
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Option 2: OpenArray™ AccuFill™ Software v2.0

Download SPF files
(page 82)

Create an array-specific template (EDT) file
(page 76)

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate
(page 84)

Map and export plate files
(page 85)

Set up and start the run with the quick run workflow
(page 87)

Remove the OpenArray™ Plate from the instrument
(page 89)

Seal and run the OpenArray™ Plates
(page 91)

Required materials for the OpenArray™ Plate workflow

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

Item Source

Instruments, software, and equipment

OpenArray™ Sample Tracker Software 1]

(Not required for OpenArray™ AccuFill™ Software v2.0)

QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 A24945

QuantStudio™ 12K Flex Real-Time PCR System with OpenArray™ block

. . 4471
(QuantStudio™ 12K Flex OpenArray™ AccuFill™ System) 090

Centrifuge, capable of spinning sample plates at 1,200 x g MLS
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(continued)
ltem Source
Plates and accessories
OpenArray™ 384-well Sample Plates, black
4482221
o 4406947
OpenArray™ 384-well Sample Plates, clear
(Optional) Biomek™ Seal and Sample Foil Lids %icuklgﬁ?
(for pre-plating step) 538619
OpenArray™ AccuFill™ System Tips 4458107
QuantStudio™ 12K Flex OpenArray™ Accessories Kitl?! 4469576
Forceps MLS
A sharp edge, blade, or scalpel (to cut the adhesive foil) MLS
A fine-tip silver or gold marker for black OpenArray™ 384-well Sample Plates
A fine-tip black marker for clear OpenArray™ 384-well Sample Plates MLS
Reagents
Genomic DNA See page 32
OpenArray™ Plates with PGx assays 4488847
TagMan™ OpenArray™ Genotyping Master Mix 4404846
100% molecular grade ethanol MLS
Nuclease-free water 4387936

1" Included with the QuantStudio™ 12K Flex Software.

[l Each kit contains the items needed to assemble up to 10 plates: 12 lids and plugs, 12 immersion fluid syringes, and 2 carriers. Each
custom OpenArray™ Plate order is shipped with accessories kits.
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Prepare the OpenArray™ Plates with OpenArray™ AccuFill™
Software v1.2

For required materials, see “Required materials for the OpenArray™ Plate workflow” on page 74.

For instructions for OpenArray™ AccuFill™ Software v2.0, see “Prepare the OpenArray™ Plates with
OpenArray™ AccuFill™ Software v2.0” on page 82.

This chapter contains brief procedures. For detailed procedures, see the following documentation.

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ AccufFill™ System User Guide 4456986

Download SPF files

To download an SPF file for a custom OpenArray™ Plate, you need the Lot# and the Serial# from the
packaging of the OpenArray™ Plate.

Note: To prepare an array-specific template EDT file, you only need to download an SPF file once. If
there is a change to the plate layout, you will need to download a new SPF file, then create a new
template.

1. Go to thermofisher.com/OA-platefiles.

2. From the Select Your Product dropdown list, select TagMan™ OpenArray™ Custom Gene
Expression/Genotyping Plates.

3. Select the desired option for downloading either only the SPF files, or downloading both the SPF
files and the AIF files.

4. Enter the Lot# and the Serial#, then click Submit.

Note: The Serial# is case-sensitive.

5. Save the SPF file to the desktop.

Create an array-specific template (EDT) file

1. Inthe ﬁ Home screen of the QuantStudio™ 12K Flex Software, in the Experiment pane, click
. Create From Template.

An Open window will appear.

2. In the Look in field, select OpenArray, click Genotyping (file name Genotyping.edt), then click
Open.

A new experiment is created using the setup information from the template.

76 Pharmacogenomics Experiments Application Guide



http://www.thermofisher.com/OA-platefiles

7.

Chapter 5 Prepare and run OpenArray™ PGx SNP genotyping experiments using EDT files ~ [Sf=a8
Prepare the OpenArray™ Plates with OpenArray™ AccuFill™ Software v1.2

From the open experiment, click the Targets tab on the left pane, then click Import » Import Plate
Setup.

Click Browse to select the SPF plate file for the desired panel, then click Select.

Click Start Import » Yes to confirm the import.

Click Save As Template to save the array-specific EDT file.

Click Save.

Generate OpenArray™ Plate layouts in the OpenArray™ Sample Tracker
Software

1.

Using a spreadsheet program, create a 96-well sample CSV file.

CSV template files can be found at <..>\Program Files (x86) \Applied
Biosystems\OpenArray Sample Tracker\examples, where <...> is the drive.

a. Navigate to the following folder, then open the 96-Well Sample Plate 1.csv template
that is provided with the OpenArray™ Sample Tracker Software.

<.>\Program Files (x86)\Applied Biosystems\OpenArray Sample
Tracker\examples, where <...> is the drive.

b. Save As the template as a new 96-well sample CSV file.
¢. Enter or copy the sample names into your 96-well sample CSV file.
Open the OpenArray™ Sample Tracker Software.

In the Properties screen, select Genotyping for Experiment Type, then select the appropriate
settings for OpenArray™ Plate and Pipettor.

In the Samples screen, click [ Import, then select and import your 96-well sample CSV file that
you created in step 1.

In the Sample Mapping screen, confirm that the samples for a single OpenArray™ Plate are
assigned to one color.

Note: If necessary, correct the OpenArray™ Plate and Pipettor settings in the Properties screen.

In the Sample Mapping screen, click Export » Export *.csv.

Note: You can export up to four CSV files at once.

Select OpenArray Plate (1, 2, 3, or 4) (for QuantStudio), enter a file name, then save the exported
file(s).
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Set up the PCR reactions in an OpenArray™ 384-well Sample Plate

IMPORTANT! The 4 x 12 areas of the OpenArray™ 384-well Sample Plate being filled must match the
areas designated in the OpenArray™ Sample Tracker Software for that set of samples.

1. Remove an OpenArray™ Plate from the freezer and set it aside. Allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ Plate must be completely thawed before transferring reactions to it from the
OpenArray™ 384-well Sample Plate created in this section.

2. If stored in the freezer, thaw your 96-well DNA sample plates (~15 minutes).

Once thawed, vortex briefly, then centrifuge each plate at 1,000 x g for 1 minute to collect liquid at
bottom of the wells.

3. Gently swirl the contents of the TagMan™ OpenArray™ Genotyping Master Mix to thoroughly mix.
Do not invert the bottle.

4. Using a new OpenArray™ 384-well Sample Plate, define the four quadrants that correspond to
each 96-well DNA sample plate with a black marker.

5. Following the plate layout designated in the OpenArray™ Sample Tracker Software, add master
mix, then UltraPure™ DNase/RNase-Free Distilled Water (NTCs) or DNA samples, to an OpenArray™
384-well Sample Plate.

OpenArray™ Plate Format

Component 16 32 64+

Volume per well

TagMan™ OpenArray™ Genotyping Master Mix 1.5pL 2.0 L 25 L
One of the following:
* UltraPure™ DNase/RNase-Free Distilled Water (NTCs) 1.5 L 2.0 L 2.5 L
* DNA sample
Total reaction volume 3.0 uL 4.0 uL 5.0 yL

6. Thoroughly mix each PCR reaction by pipetting up and down or by using the "mix" function
on a multi-channel pipette. Alternatively, vortex the OpenArray™ 384-well Sample Plate for 10-15
seconds after sealing with aluminum foil in step 7.

7. Seal the OpenArray™ 384-well Sample Plate with an aluminum foil seal, remove the foil flap, then
mark the edges of the filled 4 x 12 area with a pen.

8. Vortex the plate for 20-30 seconds, then centrifuge the plate at 1,200 x g for 1 minute.

9. Score the foil along the lines that were marked before centrifuging.
Do not remove the foil from the scored area at this time.
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If you make a sample layout error before the AccuFill™ procedure — Repeat “Generate OpenArray™ Plate
layouts in the OpenArray™ Sample Tracker Software” on page 77 with a corrected 96-well sample CSV
file.

Set up the OpenArray™ AccuFill™ Instrument and the OpenArray™ AccuFill™
Software

IMPORTANT! Do not use OpenArray™ AccuFill™ System Tips that exceed the expiration date (shown
on the outer box that contains the tip trays).

1. In the OpenArray™ AccuFill™ Software, click Setup and Load.
The Setup Load Information window appears.

2. In the Setup Load Information window, select the number of samples per subarray, then enter the
OpenArray™ Plate barcodes in the appropriate plate holder positions.

Note: Ensure that the Use Sample Integration checkbox is deselected.

Setup Load Information

Leading information

Specify the type of load you want to perform. Enter Plate and OpenAmray® Plate barcodes by
scanning them, typing them, or selecting the associated file

®_ [ Use Sample Integration Samples Per Subarray —@
Sample Plate l:l Plate Holder Position 1 ABC12

Flate Holder Position 2

L
Flate Holder Position 3 l:l
L

Plate Holder Position 4

Select Samples to Load

Click the section on the sample plate from which the firet sarmple will be extracted. The image on the
right shows how the sample will be applied to the OpenArray Plates.

Plate Holder Position 1

ABCIZ

ate Holder Position 2

LTI

ate Holder Position 3

T

ate Holder Position 4
Sample section(s) already used: 1 on 212012

EEEN
®

TN

(1) Use Sample Integration
@ Samples Per Subarray
@ Plate Holder Position corresponding to the position of the OpenArray™ Plate on the deck of the instrument.

3. In the Select Samples to Load pane (bottom section of the window), click the corresponding
4 x 12 area of the 384-well sample plate image, then click Next.
The Setup Deck window is displayed.
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4. Inthe OpenArray™ AccuFill™ Instrument, ensure that:
* Tip boxes and tips are loaded as shown in the Setup Deck window.
® The lids are removed from the tip boxes.
¢ The waste bin in the instrument is emptied.

5. In the Setup Deck window, confirm that the deck is ready:
* Select The tips are configured as shown above.
* Select The Waste Bin is empty.

Transfer reactions to the OpenArray™ Plate using the OpenArray™ AccuFill™
Instrument

IMPORTANT! Ensure that the OpenArray™ Plate is thawed and that the entire plate is at room
temperature.

1. Prepare the items needed to seal the loaded OpenArray™ Plate (next section).

Note: The OpenArray™ Plate must be sealed promptly after being loaded with the reactions, as
described here.

* Ensure that the QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 is ready.

¢ Gather and remove from their packaging the following: an OpenArray™ Lid, plug, syringe with
OpenArray™ Immersion Fluid, and syringe tip.

* Attach the syringe tip to the syringe, carefully push some of the fluid through the tip to remove
air bubbles, then lay the syringe aside.

2. Load the OpenArray™ Plate and the OpenArray™ 384-well Sample Plate into the OpenArray™
AccuFill™ Instrument.

* OpenArray™ Plate —Remove the plate from its sleeve, then place the plate in the appropriate
plate holder position in the instrument.

Ensure that the barcode on the OpenArray™ Plate is facing left and the serial number is facing
right.

* OpenArray™ 384-well Sample Plate —Place the 384-well sample plate onto the deck of the
instrument, then use forceps to peel the foil from the filled area of the plate.

3. Close the door of the instrument.

4. Inthe OpenArray™ AccuFill™ Software Setup Deck window, select the following confirmations:
* The OpenArray Plate is in the Plate Holder
* Remove foil from the highlighted section of the Sample Plate

5. Click Load.

6. As soon as the Remove OpenArray Plate window appears, open the instrument door, then
remove the loaded OpenArray™ Plate.
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7. Proceed immediately to seal the OpenArray™ Plate.
See “Seal and run the OpenArray™ Plates” on page 91.

Note: For best results, seal the OpenArray™ Plate within 90 seconds of completion of loading to
prevent evaporation.
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Prepare the OpenArray™ Plates with OpenArray™ AccuFill™
Software v2.0

For required materials, see “Required materials for the OpenArray™ Plate workflow” on page 74.

For instructions for OpenArray™ AccuFill™ Software v1.2, see “Prepare the OpenArray™ Plates with
OpenArray™ AccuFill™ Software v1.2” on page 76.

This chapter describes the full run workflow. For other workflow options, see the following
documentation.

This chapter contains brief procedures. For detailed procedures, see the following documentation.

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide MANO0025669
gg;eefz;;a;ﬂ” AccufFill™ Software v2.0 Quick Run Workflow Without Sample Information Quick MANO0025835
OpenArray™ AccufFill™ Software v2.0 Full Run Workflow Quick Reference MANO0025836

Download SPF files

To prepare an array-specific template EDT file, you only need to download an SPF file once. If there is a
change to the plate layout, you will need to download a new SPF file, then create a new template.

The computer with the OpenArray™ AccuFill™ Software v2.0 must be connected to the internet.

1. In the TPF/SPF screen of the OpenArray™ AccuFill™ Software v2.0, select the Download radio
button.

2. Select the product.

* TaqMan OpenArray Custom
* TaqMan OpenArray Inventoried
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3. Enter the following information.

Product Information
"I;aqM:n a. Enter the Lot number or Batch number.
penArray .

Custom b. Enter one Serial number from the lot.
Note: Only one serial number is required. The serial number is used to confirm the
lot number or batch number. All of the files in the lot or batch are downloaded.

TagMan Enter the list of Serial numbers or Barcodes. Separate more than one serial

OpenArray number or barcode with a comma or a line break.

Inventoried

Note: The serial number or barcode entered corresponds to the file that is
downloaded. Enter a serial number or barcode for each file to download.

Note: The fields that are displayed depend on the product selected in step 2.

4. Click Download.

The location of the files is displayed at the top of the screen. The location of the downloaded files

is set in the Preferences menu, in the OpenArray plate file folder field. See QuantStudio™ 12K Flex
OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669) for more information about setting
the preferences.

The files are in a compressed ZIP folder.

a 8 BEm & %X O
Preferences  Service

Quick Run  Full Run MapPlates  TPF/SPF  Folders Help

© Download successfully saved to D:AOpenArray\OpenArrayPlates\2577466.2ip Open folder X

Click Open folder to access the files or click X (Close) to close the message.
Extract the files from the compressed ZIP folder.
Create an array-specific template (EDT) file

1. Inthe ﬁ Home screen of the QuantStudio™ 12K Flex Software, in the Experiment pane, click
..+ Create From Template.

An Open window will appear.

2. In the Look in field, select OpenArray, click Genotyping (file name Genotyping.edt), then click
Open.
A new experiment is created using the setup information from the template.

3. From the open experiment, click the Targets tab on the left pane, then click Import » Import Plate
Setup.

4. Click Browse to select the SPF plate file for the desired panel, then click Select.

5. Click Start Import » Yes to confirm the import.
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6. Click Save As Template to save the array-specific EDT file.

7. Click Save.

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate

IMPORTANT! The 4 x 12 areas of the OpenArray™ 384-well Sample Plate being filled must match the
areas designated in the OpenArray™ AccuFill™ Software for that set of samples.

1. Remove an OpenArray™ Plate from the freezer and set it aside. Allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ Plate must be completely thawed before transferring reactions to it from the
OpenArray™ 384-well Sample Plate created in this section.

2. Gently swirl the contents of the TagMan™ OpenArray™ Genotyping Master Mix to thoroughly mix.
Do not invert the bottle.

3. Following the plate layout designated in the OpenArray™ Sample Tracker Software, add master
mix, then UltraPure™ DNase/RNase-Free Distilled Water (NTCs) or DNA samples, to an OpenArray™
384-well Sample Plate.

OpenArray™ Plate Format

Component 16 32 64+

Volume per well

TagMan™ OpenArray™ Genotyping Master Mix 1.5pL 2.0pL 2.5puL
One of the following:
* UltraPure™ DNase/RNase-Free Distilled Water (NTCs) 1.5 L 2.0 uL 2.5 L
* DNA sample
Total reaction volume 3.0 uL 4.0 yL 5.0 L

4. Thoroughly mix each PCR reaction by pipetting up and down or by using the "mix" function
on a multi-channel pipette. Alternatively, vortex the OpenArray™ 384-well Sample Plate for 10-15
seconds after sealing with aluminum foil in step 5.

5. Seal the OpenArray™ 384-well Sample Plate with an aluminum foil seal, remove the foil flap, then
mark the edges of the filled 4 x 12 area with a pen.

6. Vortex the plate for 20-30 seconds, then centrifuge the plate at 1,200 x g for 1 minute.

7. Score the foil along the lines that were marked before centrifuging.
Do not remove the foil from the scored area at this time.

If you make a sample layout error, it is possible to correct this in the OpenArray™ AccuFill™ Software
using the plate rotation feature. For more information, see QuantStudio™ 12K Flex OpenArray™ AccuFill™
System User Guide (Pub. No. MAN0025669).
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Map and export plate files

Configure the experiment design to map the plates

A sample plate file (CSV file) is not required.

Navigate to the Map Plates screen.

1.

2.

w

P

5.

In the Configure design pane, in the Experiment type section, select Genotyping

In the Plate format section, select a value.

. In the Sample input type section, select the type of plate.

e 96-well
s 384-well

In the Pipettor section, select a type of pipette.

* Fixed
¢ Adjustable

Click Next.

The Map plates pane is displayed.

If 96-well was selected in step 3, proceed to “Map a 384-well plate from 96-well plates” on page 85.

If 384-well was selected in step 3, proceed to “Set up a 384-well sample plate” on page 86.

Map a 384-well plate from 96-well plates

1.

In the Map Plates pane, add the sample name in the 96-well plate.
Click and drag to copy and paste sample names across a row or down a column.

Note: The sample names are copied. They are not automatically filled. For example, if Sample 1
is the first sample name, all of the wells that are filled by the click and drag feature are Sample 1.
They are not named sequentially, for example, Sample 1, Sample 2, Sample 3.

(For Genotyping 256 plate formats) In the 96-well plate, select a sample run.
e Sample Run 1
e Sample Run 2

If Sample Run 1 is selected, the top half of the 96-well plate is defined with the samples. If
Sample Run 2 is selected, the bottom half of the 96-well plate is defined with the samples.

This feature allows for two runs with a 96-well plate, if only 48 wells of the physical plate are used.

(Optional) In the 384-well plate, click Swap.

This moves the samples from the top half of the 384-well plate to the bottom half of the 384-well
plate.
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s

Note: The Swap button is displayed only if certain experiment types and plate formats are
selected. It is displayed when half of the 384-well plate is used.

(Optional) Click Import to import a sample file (CSV format).

A sample file can be imported from the Map plates pane if it was not imported from the Configure
design pane.

Note: If a sample plate file is imported from the Map plates pane, the information will overwrite
any information from files that were imported from the Configure design pane.

Proceed to “Export plate files” on page 87.

Set up a 384-well sample plate

If the sample plate file was imported, the sample names are displayed. The sample plate layout defined
in the sample plate file can be edited.

If the sample plate file was not imported, the samples must be added manually.

The plates are color-coded for the position on the OpenArray™ Plate based on how the experiment is
configured.

1.

In the Map Plates pane, add the sample name to the 96-well plate.
Click and drag to copy and paste sample names across a row or down a column.

Note: The sample names are copied. They are not automatically filled. For example, if Sample 1
is the first sample name, all of the wells that are filled by the click and drag feature are Sample 1.
They are not named sequentially, for example, Sample 1, Sample 2, Sample 3.

(Optional) Click Import to import a sample plate file (CSV format).

A sample plate file can be imported from the Map plates pane if it was not imported from the
Configure design pane.

Note: If a sample plate file is imported from the Map plates pane, the information will overwrite
any information from files that were imported from the Configure design pane.

(Optional) Click Rotate data.

The 384-well plate can be placed inside the OpenArray™ AccuFill™ Instrument in only one
orientation. If the samples were added to the physical 384-well plate in the incorrect orientation,
the physical 384-well plate cannot be rotated when it is placed in the instrument for the sample
plate file to match. The option to rotate the samples in the sample plate file allows the 384-well
plate to be used in the correct orientation for the instrument with a matching sample plate file.

The Rotate data feature is available only in the Map Plates screen if a 384-well sample plate file
was imported. It is not accessible in the full run workflow.

Proceed to “Export plate files” on page 87.
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Export plate files

1.

5.

In the Map plates pane, click Export.
The Select Plates to Export dialog box is displayed.

Select CSV file as the file type to export.
Select the OpenArray Plate (for QuantStudio) as the plate file to be exported
Enter a prefix for the exported file name in the File Name Prefix field.

Click OK.

Set up and start the run with the quick run workflow

Before you begin—quick run workflow

Prepare samples (DNA and PCR reaction mix) in a 384-well plate, according to the user guide or
the application guide for your assay. Distribute the samples according to the layout determined in
the Map Plates workflow.

Place the sample plate in the sample plate holder on the instrument deck, with the notch to the left.
Do not stack sample plates.

Load the tip boxes, then remove the tip box covers.
Do not stack the tip boxes.

Place the OpenArray™ Plate in the plate holders.
Clear the instrument deck, empty and replace the waste bin, and close the instrument door.

Prepare the QuantStudio™ 12K Flex OpenArray™ Accessories Kit materials that are required to seal
the OpenArray™ Plate.

IMPORTANT! OpenArray™ Plates must be sealed immediately after loading. For more information,
see the user guide or application guide for your assay.

Configure the run without sample plate information

A sample plate file (CSV file) is not required by the OpenArray™ AccuFill™ Software v2.0.

Navigate to the Quick Run screen. Ensure that the Load without sample plate information radio
button is selected.

1.

(Optional) In the Quick Run screen, in the Sample plate - optional field, enter information to
identify the sample plate.

* Enter the information about the sample plate.
* Use a barcode scanner to scan the sample plate or manually enter the barcode text string.
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2. Select the number of samples per subarray.

* One
* Two
* Three

3. In the OpenArray Plate name and position field, enter information to identify the OpenArray™
Plate.

We recommend using the serial number of the OpenArray™ Plate as the identifying information.
The name and position are recorded in the loading history log.

4. Click a section of the sample plate to change the corresponding OpenArray™ Plate.

Note: The first section of the sample plate is selected. Subsequent sections are selected
automatically.

During the run, the instrument fills the OpenArray™ Plate with the samples from the corresponding
section of the sample plate.

The OpenArray™ Plate position displays the color that corresponds to the section of the sample
plate.

If there is more than one sample in a subarray, the position box displays all the colors associated
with the corresponding sample.

P

Select the sgmple plate area to begin OpenArray plate name and position

(1) Sample plate section
@ Corresponding OpenArray™ Plate

Verify the run setup and start the run

1. Click each tip box so that the status on the Verify the run setup and start the run section
matches the physical tip box in the instrument.
We recommend starting the run with full tip boxes.
The instrument does not start the run if there are not enough tips on the deck.
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Update the state of the tip boxes
@ Section of the tip box is full
@ Section of the tip box is empty

2. Select the first section of the sample plate to fill the OpenArray™ Plate.

Select the first section of the sample plate if multiple OpenArray™ Plates are filled during a run. The
software selects the total number of sections that correspond with the total number of OpenArray™
Plates.

3. Remove the foil from the appropriate sections of the sample plate, then click the checkbox to
confirm.

Remove the foil only from the sections of the sample plate that are used to load a single
OpenArray™ Plate.

The number of sections that the foil is removed from depends on how the run was set up. For
example, if the run was set up without sample information and for two samples per subarray, the
foil is removed from two sections at a time.

Note: Do not remove the foil from all the sections of the sample plate at once.

4. Close the instrument door.

5. Click Start Run.
The run does not begin under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The OpenArray™ Plates are not in position

* There are more OpenArray™ Plates on the instrument deck than are defined in the experiment
setup

The Deck screen is displayed.

IMPORTANT! Each OpenArray™ Plate must be prepared for PCR immediately after it is filled.

Remove the OpenArray™ Plate from the instrument

1. Open the instrument door and remove the OpenArray™ Plate that is indicated by the blue box in
the dialog box.

IMPORTANT! Remove the OpenArray™ Plate within 30 seconds, to avoid evaporation within the
plate.
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One of the following dialog boxes is displayed:
* The Remove plate and foil dialog box.
* The Remove plate dialog box (after the last OpenArray™ Plate is filled).

2. Seal the case and fill the OpenArray™ Plate with immersion fluid.
See “Seal the OpenArray™ Plate” on page 91.

3. (For Remove plate and foil dialog box only) Remove the foil seal from the next section of the
sample plate, then select the checkbox to confirm that the foil is removed from the section of the
plate that is highlighted.

Note: Remove the foil only from the next section of the sample plate. Do not remove the foil from
all sections of the sample plate.

4. Close the instrument door.

5. Click Done.
The run does not proceed under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The OpenArray™ Plates are not in position
* There are more OpenArray™ Plates on the instrument deck than are defined in the experiment
setup

The instrument loads the next OpenArray™ Plate.

6. Repeat step 1to step 5 for each OpenArray™ Plate to be loaded.
See “Seal and run the OpenArray™ Plates” on page 91.

Note: For best results, seal the OpenArray™ Plate within 90 seconds of completion of loading to
prevent evaporation.

After all of the OpenArray™ Plates have been loaded, the Deck screen displays Run completed
successfully. Empty the waste bin before performing another run.
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Seal and run the OpenArray™ Plates

Seal the OpenArray™ Plate

IMPORTANT! Throughout this procedure, handle the OpenArray™ Plate and the OpenArray™ Case only
by the edges.

Note: The OpenArray™ Case consists of the sealed OpenArray™ Plate and the OpenArray™ Lid.

1. Place the newly loaded OpenArray™ Plate in the QuantStudio™ 12K Flex OpenArray™ Plate
Press 2.0.

Ensure that the barcode is facing left and the serial number is facing right.

2. From the OpenArray™ Lid, remove the clear protective film from the inside of the lid D and the red
adhesive-protective strip @ from around the edge of the lid.

o2 6

Figure 4 OpenArray™ Lid

@ Protective film on inside of the lid (remove before sealing)

@ Red adhesive-protective strip (remove before sealing)

@ Protective film on the outside of the lid (remove before running)
@ Notched end (align with serial number on plate)
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3. Place the lid in the Plate Press using the alignment pins of the Plate Press for orientation.

IMPORTANT! The notched end of the case lid must be oriented towards the furthest back
right-side of the Plate Press.

@ OpenArray™ case lid
(@ Notched end of lid
@ Serial number of plate
@ OpenArray™ Plate

@ Barcode of plate

(® Alignment pins

4. Seat the lid on the OpenArray™ Plate with the lid adhesive against the plate.

5. Engage the press mechanism until the green flashing light changes to a steady green light (after
20 seconds).

The status light turns solid green, indicating that the case is sealed.

Note: Do not apply additional pressure onto the Plate Press during its actuation.

6. Disengage the press and carefully remove the OpenArray™ Case.

7. Prepare the immersion fluid. Remove the cap, insert the accompanying syringe tip, and prime the
syringe by ejecting a small amount of immersion fluid onto a paper towel to ensure no air gap
remains in the newly attached pipette tip.

IMPORTANT! If the syringe is not primed, the direct burst of air and fluid can negatively affect the
assay(s) at the end of the array.
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8. While holding the case upright by its edges at a 15-30 degree angle so that the port is at the
highest point of the array, insert the prepared syringe tip into the port in the case.

The syringe tip must be in front of the array when filling the case with immersion fluid.

9. Slowly inject the OpenArray™ Immersion Fluid until the case is filled, which should take about 10
seconds to fill. Minimize the creation of additional air bubbles when you dispense the fluid. Leave a
small air bubble as shown below.

IMPORTANT! If injected too quickly, the fluid can flush out the samples that are suspended in the
through-holes.

Overfilling the array and/or not leaving a small bubble may cause a leak during the PCR run.
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10. While holding the case vertically, remove the syringe tip, insert the screw end of the OpenArray™
plug into the port of the case, then rotate clockwise until the black handle breaks off.

Note: Ensure that you are screwing the plug in at the same angle the case base is at. If it is off, it
can cause the plug to break off prematurely.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and rotate the plug
slowly to avoid cross-threading.

If the plug handle breaks off prematurely, use a Phillips #0 screwdriver to complete this step. Do
not overtighten. If plastic or adhesive remains attached to the screw due to premature breakout of
the plug handle, remove it with forceps prior to loading it into the instrument.

11. If needed, clean the case with the lint-free cloth included with the OpenArray™ Plate or a laboratory

wipe that has been thoroughly sprayed with ethanol, then dry the case with a clean laboratory
wipe.

Integrate sample names before or after the run

Note: You can choose to integrate samples names before or after the run. If you choose to integrate
samples names after the run, proceed immediately to “Run an array-specific template EDT or EDS file”
on page 95.

1. At the top of the screen, click Tools » Preferences.
The Preferences window is displayed.

2. Click the OpenArray tab.

3. Next to the Setup Folder field, click Browse.
a. Open your experiments folder.

b. Create and name a new folder within the experiments folder (e.g., Templates for OA).

4. Inthe ﬁ Home screen of the QuantStudio™ 12K Flex Software, in the Experiment pane, click
Open.

a. Navigate to the folder you made in substep 3b.
b. Select the desired EDT file, then click Open.

5. In the Setup pane, click the Samples tab, then click Import.

a. Select the OpenArray™ Plate sample information CSV generated from the OpenArray™ Sample
Tracker Software or Map Plates.

b. Click Select File.

6. In the Setup pane, click the Experimental Properties.
a. In the Experiment Name field, enter in the experiment name.

b. In the Barcode field, enter in the serial number of the plate you are running.
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7. At the top of the screen, click [5] Save » Save As to save the file in EDS format.

8. Click Save.

Run an array-specific template EDT or EDS file
1. Inthe ﬁ Home screen of the QuantStudio™ 12K Flex Software, in the Run pane, click OpenArray.

2. In the Setup OpenArray Run pane, click Get Plate IDs.
The plate ID information will populate. This may take several minutes.

3. Click Browse next to the Setup File field.

4. Under the Files of type dropdown menu, change the file type from SPF to EDT.

Note: Change the file type from SPF to EDS if you completed “Integrate sample names before or
after the run” on page 94.

5. Select the desired EDT or EDS file, then click Select.

6. (Optional) Click Browse to change the Experiment File Location.

7. (Optional) Change the software-determined Experiment File Name.

8. Click Start Run.

9. Transfer the EDS file from the instrument to an accessible location for analysis.

10. Check the QC images for loading issues or leaks.

Note: If you did not integrate samples names before the run, proceed to “Integrate sample names
before or after the run” on page 94.

Check the quality—-control images

Check the quality—control (QC) images before analysis. Images can be viewed using Imaged, an open-
source software available from the NIH at imagej.nih.gov/ig.

1. In the QuantStudio™ 12K Flex Software ?ﬁ Export screen, click Browse, then create a uniquely-
named folder for the QC images export.

IMPORTANT! Create a new folder for images each time. Exporting a second run to the same
folder overwrites the images.

2. Click Export QC Images at the bottom of the screen.

3. View the following ROX™ image to check for loading quality issues:
¢ POST-READ_CHANNEL_A4.tiff
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4. Check the following spotfinding images for leaks or other displaced sample issues.
e s02_c001_t03_p0001_m1_x2_el1_cp#_spotfind.tiff
* s02_c040_t03_p0001_m1_x2_e1_cp#_spotfind.tiff

Note: The “cp#” in the image file name refers to array positions 1 through 4 within the instrument.

5. If a problem is found, view the following pre-run spotfinding image to determine whether the issue
existed before cycling:

* s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiff

6. View the following FAM™ images to check for fluorescent abnormalities and to confirm any
problem seen in the spotfinding images:

e STAGE2_CYCLE1_CHANNEL _1.tiff
¢ STAGE2_CYCLE40_CHANNEL_1.tiff

7. Note any abnormalities found, as well as all other potentially relevant information related to the
setup of the run.
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This chapter contains brief procedures. For detailed procedures, refer to:

Title Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ AccufFill™ System User Guide 4456986
OpenArray™ SNP Genotyping Experiments MANO0014351
TagMan™ OpenArray™ Genotyping Troubleshooting Guide MANO0011115
TagMan™ Genotyper Software Getting Started Guide 4448637
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Before you begin analysis (each time)

Transfer files from QuantStudio™ 12K Flex Real-Time PCR System software
with a network connection

1. In the Home screen of the QuantStudio™ 12K Flex Real-Time PCR System Software, click
Instrument Console.

2. In the Instrument Console, select the desired QuantStudio™ 12K Flex Real-Time PCR System from
the list of instruments on the network, then click Add to My Instruments.

3. After the QuantStudio™ 12K Flex Real-Time PCR System is added to your list, select it, then click
Manage Instrument.

4. In the Instrument Manager, click Manage Files, then click File Manager.

5. In the File Manager screen, transfer the file(s) from the QuantStudio™ 12K Flex Real-Time PCR
System:

a. In the Folders field, select the folder that contains the files that you want to download.

b. In the Experiments field, select the files to download. To select multiple files, Gtrl-click or
Shift-click files in the list.

¢. When you have selected the files that you want to download, click Download.

d. In the Send experiment to instrument dialog box, select the folder to which you want to
download the selected file(s), then click Open.

For more details on file transfers, see the networking chapter in the QuantStudio™ 12K Flex Real-Time
PCR System Maintenance and Administration Guide (Pub. No. 4470689).

Transfer files from QuantStudio™ 12K Flex Real-Time PCR System Software
without a network connection

Download and save files in one of the following ways:

* Connected computer
— Browse for the folder containing the run.

— Select run names and download the file to storage media.

* |nstrument only
— Insert a USB storage device into one of the USB ports in the front panel.
— Use the touchscreen and press Collect Results.
— Select run names and press Save to USB.
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Analysis options for genotyping data

Analyze allelic discrimination plots for genotyping data using any of these tools:

Software

Features

QuantStudio™ 12K Flex Real-Time PCR System
software

Desktop software

View real-time trace data to aid genotype calling

Thermo Fisher™ Connect Genotyping Application

Cloud software

Create studies

Overlay data from multiple plates

View real-time trace data to aid genotype calling

TagMan™ Genotyper Software

Desktop software
Create studies

Overlay data from multiple plates

Analyze data in QuantStudio™ 12K Flex Real-Time PCR

System or Connect software

For non-standard assays, review the data for both assays together to ensure accurate genotyping

results.

To use the QuantStudio™ 12K Flex Real-Time PCR System software or related instrument software:

1. In the analysis settings, select Analyze Real-Time Rn — Median (Rna to Rnb). This setting will
normalize for any run and system noise to improve data accuracy.

2. Select Analysis » Allelic Discrimination Plot.

To use the Connect GT Analysis module:

1. Go to thermofisher.com/cloud.

2. Create a project and import one or more OpenArray™ experiment files (.eds).

3. Access the Genotyping (GT) application.
4. Analyze data.
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Analyze data with TagMan™ Genotyper Software

Before you begin TagMan™ Genotyper Software analysis

Create a study template

If using a reference panel, generate the reference panel before creating the study template, so that the
reference panel can be imported into the template.

First download the Assay Information File (AIF) from http://www.thermofisher.com/OA-platefiles.

—h

. In the TagMan™ Genotyper Software Home screen, click Create Study.

2. In the Workflow Menu pane, select Setup » Properties, then enter the study properties.
* For Instrument Type, select QuantStudio™ 12K Flex Real-Time PCR System.
* For Experiment Type, select Real-time.

3. In the Workflow Menu pane, select Setup » Assays.
4. Click Import, then select and import the Assay Information File (AIF).

5. (Optional) Import the reference panel:
a. In the Workflow Menu pane, select Setup » References.

b. Click Import, then select and import the reference panel file of interest.

6. Select File » Generate Template, enter a template name (EDT), then save the template in the
desired location.

(Optional) Generate a reference panel

A reference panel consists of high-quality data for all the assays in the study. The data can be chosen
from multiple SNP Assays.

For best results, generate a new reference panel for each lot of SNP Assays.

If necessary, first create a study containing data that will be used as reference samples. For the study
properties options, set QuantStudio™ 12K Flex Real-Time PCR System for Instrument Type, and
Real-time for Experiment Type.

1. In the TagMan™ Genotyper Software, open the study that contains data points to be used as
reference samples.

2. In the Workflow Menu pane, select Analysis » Results.

3. Click-drag in the scatter plot to select one or more data points.

Select data points for each homozygous genotype (FAM™ dye-labeled or VIC™ dye-labeled) and
the heterozygous genotype.

The non-selected data points will fade.

4. Right-click in the scatter plot, then select Tag for Ref Panel.
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Repeat the selection and tag steps for additional data points.

Confirm that the correct samples have been tagged as reference samples in the Results table.

In the Results tab, Reference Sample must be selected in the View dropdown list to view the
tags.

Repeat the data point selection, tagging, and confirmation steps for each SNP assay of interest.
Select File » Save.

Select File » Generate Reference Panel, enter a name for the panel, then save the file (.lap) to the
desired location.

(Optional) Add samples to an existing reference panel

During analysis in TagMan™ Genotyper Software, you can add samples to an existing reference panel.

The reference panel must already be imported into the study containing samples that will be added to
the reference panel.

1.

In the scatter plot of the study, select data points for the samples of interest, right-click in the plot,
then select Tag for Ref Panel.

Select File » Save.

Select File » Generate Reference Panel, enter a name for the panel, then save the file (.lap) to the
desired location.

Analyze results in TagMan™ Genotyper Software

1.

In TagMan™ Genotyper Software, click Create Study from Template, then select and open the
desired template (LAT).

Note: If you have not created a template, see “Create a study template” on page 100.

In the Workflow Menu pane, select Setup » Experiments.
Click Import, then select and import one or more OpenArray™ experiment files (EDS).
Click Analyze.

Inspect the call data for the SNP assay in the scatter plot.

Refer to the TagMan™ Genotyper Software Getting Started Guide (Pub. No. 4448637) for detailed
instructions.

(Optional) To manually assign the genotype, select the sample(s), right-click, then select the
genotype.

Select Inspected next to the assay, then click Save.

Repeat the inspection for each SNP assay.
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9. In the Workflow Menu pane, select Export » Analysis Data.

10. In the Export Study Properties pane:
a. Select Analysis Results » Advanced.

b. Select One File.
c. Enter the filename and location, and select (*.txt).

11. Click Export preview, then click Start Export in the new window.

Review call rates and other QC parameters

Select the appropriate tab to review call rates and other QC parameters in TagMan™ Genotyper
Software.

To... Do this...

Review sample call

a. Select Analysis » Quality Control.
rates and QC data

b. Select the Samples tab to review the sample call rates and other QC
parameters. Samples with low call rates are an indication of poor sample
quality or concentration and it is advisable to omit those samples from the
study.

c. (Optional)To omit samples with poor quality or concentration, right click the
sample name, select Omit from the dropdown menu, then reanalyze the data.

Review plate call a

. Select Analysis » Quality Control.
rates and QC data

b. Review call rates and QC data in the Experiments tab.

Review assay call

a. Select Analysis » Quality Control.
rates and QC data

b. Review call rates and QC data in the Assay tab.

For detailed instructions, see the TagMan™ Genotyper Software Getting Started Guide
(Pub. No. 4448637).

Analysis guidelines: sex chromosome targets

In most cases, Use Hardy-Weinberg for Analysis is selected. X and Y chromosome-specific SNP
targets do not follow a Hardy-Weinberg distribution.

To improve the accuracy of genotype calls for SNP targets on the X and Y chromosomes:
* Deselect Use Hardy-Weinberg for Analysis
* Select Disallow in Males from the Heterozygote drop-down list

Note: If you select Disallow in Males for other types of targets, the genotype call accuracy may be
negatively impacted.
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SNP targets located in the PAR region of the X and Y chromosomes behave like autosomal SNP targets
and males can be heterozygotes. The gender assay (C_990000001_10) target X— and Y- chromosome
specific sequences in the amelogenin gene: males run as heterozygotes and females run as VIC™
homozygotes. Do not select Disallow in Males with these assay types.

Analysis guidelines: DME genotyping assays for genes in
copy number variation regions

Some TagMan™ DME Assays target polymorphisms in genes that exhibit copy number variation
including CYP2D6, CYP2A6, CYP2E1, GSTM1, GSTT1, and SULT1A1. Copy number variation analysis
must be done in addition to genotyping with DME assays. The frequency of the CYP2D6, CYP2A6,
CYP2E1, and SULT1A1 gene deletions are low, and samples that carry no copies of these genes will
be rare. However, the frequency of deletion of GSTM1 and GSTT1 genes is very high in a number of
populations and complete absence of these genes in individuals is common.

For a given DME assay that targets a gene that can be deleted or duplicated, the following genotyping
results are possible:

* |f both copies of a gene are deleted in a sample (copy number of 0), samples will not be amplified
and will run with NTCs. If a sample running near the NTCs has been called as undetermined, that
call can be manually adjusted to "noamp”.

* |f a sample contains 1, 2, or more than 2 copies of the gene and only one SNP allele is present, the
samples will cluster together in a homozygous allele. Clusters will sometimes show some splitting:
samples containing less target can run closer to the NTCs than those containing more copies of the
target.

* |f a sample carries more than 2 copies of a gene and both SNP alleles are present, it will fall within
the heterozygous cluster or off to one side or the other of the cluster (that is, the heterozygous
cluster may exhibit some spreading). If a sample close to the heterozygous cluster has been called
as undetermined, manually adjust the call to heterozygous.

Analysis guidelines: SNP genotyping assays for triallelic
SNPs

Triallelic SNPs are interrogated using two TagMan™ assays.

Example:
* Assay 1—Major SNP allele (labeled with VIC™ dye) and first minor allele (labeled with FAM™ dye)

* Assay 2—Major SNP allele (labeled with VIC™ dye) and second minor allele (labeled with FAM™
dye)
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Analysis guidelines: SNP genotyping assays for triallelic SNPs

Expected results:

* Samples that are heterozygous for the detected SNP alleles will run as heterozygous with the assay
designed to that mutant allele.

* Samples running in or near a homozygous cluster can be a true homozygote for the reported allele,
or the sample can be a heterozygote for a reported allele and for the unreported SNP allele of a
given assay. Samples with one reported allele in an assay can sometimes run together, or close
to, those carrying two reported homozygous alleles. If a sample close to a homozygous cluster is
called as undetermined, manually change the call to homozygous.

* Samples that are homozygous for the unreported SNP allele may cluster with NTCs or may exhibit
weak amplification due to probe nonspecific activity. If a weakly amplifying sample is called as
undetermined, manually adjust the call to 'noamp’.

Manually determining genotype:

Use the table below to manually determine the sample genotypes. Note that the alleles reported by the
ABCB1 SNP assays are given in the (+) strand genome orientation whereas the ABCB1 gene maps to
the (=) genome strand. Thus, the reported SNP assay alleles and the SNP cDNA annotations are the
reverse complement of one another.

Table 12 Translation table for the ABCB1 ¢.3095G>T/A triallelic SNP rs2032582 assays

Genotype C/T assay C/A assay
c.3095G>A, A893S c.3095G>T, A893T
ABCB1 ¢.3095G>T/A C_11711720D_40 C_11711720C_30
G/G C/C C/C
G/A Cc/T C/C
A/A T/T noamp
G/T C/C C/A
T/A T/T A/A
T/T noamp A/A
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Figure 5 Triallelic SNP rs2032582 assay results Left: ABCB1 ¢.3095G>A assay (C_11711720D_40) to the plus strand C
wild type and T mutant allele. Right: ABCB1 ¢.3095G>T assay (C_11711720C_30 ) to the C wild type and A mutant allele.

Analysis guidelines: DME genotyping assays for adjacent
SNPs

Pairs of assays are available for some adjacent SNP targets for which only three haplotypes are noted.
For a given assay to one SNP allele:

* Samples that are heterozygous for the detected haplotypes will run as heterozygous with the assay
designed to that haplotype.

* Samples running in or near a homozygous cluster can be a true homozygote for the reported
haplotype, or the sample can be a heterozygote for a reported haplotype and an unreported
haplotype of a given assay. Samples having just one reported haplotype may run together with, or
close to, those carrying two reported homozygous haplotypes. If a sample close to a homozygous
cluster is called as undetermined, manually change the call to homozygous.

* Samples that are homozygous for the unreported haplotype may cluster with NTCs or may exhibit
weak amplification due to probe nonspecific activity. If a weakly amplifying sample is called as
undetermined, manually adjust the call to "noamp”.

Table 13 Translation table for the CYP2C19*2,¥10 adjacent SNP assays

Haplotype/ Haplotype Diplotypes!!! *2 assay 681 G/A - 680C *10 assay 681G - 680 C/T
- CYP2C19 C__25986767_70 C__30634128_10
G-C/G-C *1/1 G/G C/C
G-C/G-T *1/*10 G/G c/T
G-C/A-C *1/%2 G/A C/C
G-T/G-T *10/*10 noamp T/T
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Table 13 Translation table for the CYP2C19*2,*10 adjacent SNP assays (continued)

Haplotype/ Haplotype Diplotypes'! *2 assay 681 G/A - 680C *10 assay 681G - 680 C/T
G-T/A-C *2/*10 A/A T/T
A-C/A-C *2/*2 A/A noamp
[ Since the *2 and *10 alleles have not been observed to occur on the same chromosome, diplotypes containing A-T haplotypes are
not included.
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Figure 6 CYP2C19*2 and *10 assay OpenArray™ results Left: rs4244285 CYP2C19*2 681G>A assay (C__
25986767_70 ) to the G wild type and A mutant allele. Right: rs6413438 CYP2C19*10 ¢.680C>T assay (C__30634128_10) to
the C wild type and T mutant allele. Samples: Coriell gDNAs; NA17263 has a *2/*2 diplotype that cannot be detected by the *10

assay.
Table 14 Translation table for the CYP2C9*3,*4 adjacent SNP assays
Haplotype/ Haplotype Diplotypes!!! *3 assay 1075 A/C -1076T *4 assay 1075A - 1076 T/C
— CYP2C9 C__27104892_10 C__30634131_20
A-T/A-T 1/ A/A /T
A-T/C-T *1/*3 A/C T/T
A-T/A-C *1/*4 A/A T/C
C-T/C-T *3/*3 C/C noamp
C-T/A-C *3/*4 C/C C/C
A-C/A-C *4/*4 noamp C/C
Y $in|cz trée *3 and *4 alleles have not been observed to occur on the same chromosome, diplotypes containing A-A haplotypes are not
Includead.
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Related documentation
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Figure 7 CYP2C9*3 and *4 assay OpenArray™ results Left: rs1057910 CYP2C9*3 ¢.1075A>C assay (C__27104892_10)
to the A wild type and C mutant allele. Right: rs56165452 CYP2C9*4 c. 1076T>C assay (C__30634131_20) to the T wild type and
C mutant allele. Samples: Coriell gDNAs; NA17247 has a *3/*3 diplotype that cannot be detected by the *4 assay. Note that the *3

heterozygous samples run in the lower portion of the split wild type FAM cluster in the *4 assay.

Related documentation

Title Pub. No.
TagMan™ Genotyper Software Getting Started Guide 4448637
TagMan™ OpenArray™ Genotyping Troubleshooting Guide MANOO11115
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B Introduction to copy number analysis ... ... 108
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B Performreal-time PCR . ... .. e 111
B Analyze the run in the instrument software and exporttheresults ........... ... . ... . .... 112
B Analyze results in CopyCaller™ Software .. ...........oueiirriie it 112
B Review the copy number analysisdata ......... ... i 114

This chapter contains brief procedures. For detailed procedures, refer to:

Title Pub. No.
TagMan™ Copy Number Assays User Guide 4397425
CYP2D6 Allele-specific Copy Number Analysis Quick Reference MANO0011114
CopyCaller™ Software v2.0 User Guide 4400042

Introduction to copy number analysis

Copy number variation must be assessed for DME genes that are known to exhibit copy number
variation. For full details on running TagMan™ Copy Number Assay experiments, refer to the TagMan™
Copy Number Assays User Guide (Pub. No. 4397425). The protocol provides step-by-step instructions
for performing and analyzing copy number variation quantitation experiments using TagMan™ Copy
Number Assays and TagMan™ Copy Number Reference Assays for the ViiA™ 7 Real-Time PCR System.
The same instructions apply for running experiments on the QuantStudio™ 12K Flex Real-Time PCR
System.
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How TagMan™ Copy Number Assays work

TagMan™ Copy Number Assays are run simultaneously with a TagMan™ Copy Number Reference Assay
in a duplex real-time PCR reaction. The TagMan™ Copy Number Assay detects the target gene or
genomic sequence of interest, and the TagMan™ Copy Number Reference Assay detects a sequence
that is known to exist in two copies in a diploid genome (for example, the human RNase P H1 RNA
gene).

The number of copies of the target sequence in each test sample is determined by relative
quantification (RQ) using the comparative CT (AAC;) method. This method measures the C; difference
(ACy) between target and reference sequences, then compares the AC; values of test samples to a
calibrator sample(s) known to have two copies of the target sequence. The copy number of the target is
calculated to be two times the relative quantity, because the human genome is diploid.

In a copy number quantification reaction, purified genomic DNA is combined with:

* The TagMan™ Copy Number Assay, containing two primers and a FAM™ dye-labeled MGB probe to
detect the genomic DNA target sequence.

* The TagMan™ Copy Number Reference Assay, containing two primers and a VIC™ dye-labeled
TAMRA™ probe to detect the genomic DNA reference sequence.

® One of the following master mixes:
— (Recommended) TagPath™ ProAmp™ Master Mix
- TagMan™ Genotyping Master Mix
Reactions are run on an Applied Biosystems™ Real-Time PCR System. After amplification, data files
containing the sample replicate CT values for each reporter dye can be exported from the real-time

PCR instrument software and imported into a software analysis tool. Applied Biosystems™ CopyCaller™
Software is recommended for post-PCR data analysis of copy number quantification experiments.

Procedural guidelines

* Use 10 ng of high-quality DNA per reaction.

* Run quadruplicate reactions for each DNA sample. The SampleFile 384-Well Plate 192-
Format .x1sx assumes quadruplicate reactions in 384-well plates.

* For quality metrics calculations, each plate should contain enough samples such that there will be
at least 7 samples with the same copy number.

* Include a no template control (NTC) reaction in each plate. In place of the DNA sample, use the
same diluent used to dilute the DNA.

* Include one or more samples of known copy number as controls (reference or calibrator sample).
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Before you begin

* Normalize the DNA samples: dilute each DNA sample to 5 ng/pL in nuclease-free water or 1X TE
buffer in a total of 10 pL.

Use the SampleFile 384-Well Plate 192-Format.xlsx to calculate the dilutions based on
the concentration determined from the RNase P assay.

* Generate the CNV Sample .txt file from the SampleFile 384-Well Plate 192-Format.xlsx.

Set up PCR reactions

1. Prepare the reagents:

a. Completely thaw the assays, gently vortex, then briefly centrifuge to bring the contents to the
bottom of the tube.

b. (Large-scale copy number assays (60X) only) Dilute the assay 1:3 (final concentration 20X) with
1X TE, pH 8.0.
For example, combine 10 pL of 60X assay with 20 pL of TE.

c. Swirl the master mix to mix contents thoroughly.

2. Prepare the reaction mix: combine the following components, invert or flick the tube to mix, then
centrifuge briefly to bring the contents to the bottom of tube.

a. Combine the components according to the table.

Note: We recommend using four replicates of each sample.

Component Volume per 10-pL reactionl!!
TagPath™ ProAmp™ Master Mix2! 5.0 uL
TagMan™ Copy Number Assay (20X) 0.5 L
TagMan™ Copy Number Reference Assay (20X) 0.5 L
Nuclease-free water 2.0 L
Total volume 8.0 uL

M Use the SampleFile 384-Well Plate 192-Format.x1sx to calculate volumes for multiple
reactions.

[l TagMan™ Genotyping Master Mix (2X) can also be used.

b. Invert or flick the tube to mix, then centrifuge briefly.
3. Transfer 8 pL of the reaction mix to the sample and control wells of a 384-well reaction plate.

4. Vortex the normalized gDNA samples (5 ng/pL), add 2 pL of each sample or control to the
appropriate wells of the plate, then mix by pipetting up and down several times.
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A

Perform real-time PCR

5. Briefly centrifuge the plate to ensure the reaction mixes are at the bottom of each well and to

minimize air bubbles.

6. Seal the plate with MicroAmp™ Optical Adhesive Film, ensuring that all 4 edges have a tight seal.

Perform real-time PCR

1. Create an experiment in the instrument software with these properties:

Property Setting
Experiment type Standard Curve
Reagents TagMan™ Reagents
Run speed Standard

2. In the Define screen, enter the Target name, then select the appropriate Reporter and Quencher

for the target.

Assay Reporter Quencher
TagMan™ Copy Number Assay FAM™ dye MGB-NFQ
TagMan™ Copy Number Reference Assay VIC™ dye TAMRA™ dye

3. In the Assign screen:

* Import the CNV Sample TXT file generated from the SampleFile 384-Well Plate 192-

Format.x1lsx, or manually assign sample names to the appropriate wells.

* Assign both assays to each well.

4. In the Run Method screen:
* Set the reaction volume to 10 pL.

¢ Confirm the following thermal cycling parameters.

Stage Step Temperature Time
Hold Step 1 95°C 10 minutes
PCR Step 1 95°C 15 seconds
(40 cycles) Step 2 60°C 60 seconds

5. Save the experiment, load the sealed plate into the instrument, then start the run.
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Analyze the run in the instrument software and export the
results

1. In the Analysis tab of the experiment, click Analyze.

2. In the Amplification Plot for each target, deselect Auto Threshold, then set the C; threshold to
0.2. Alternatively, use 0.1 as needed to ensure that the threshold is in the middle of the log phase.

Keep Auto Baseline selected.

Amplification Plot

Options

Target: Cyp2D6 exon 9 v: Threshold: || Auto 0.2 [#] Auto Baselne

Show: [¥] Threshold — [] Baseline Start: Wel M Target 4 Baselne End: Wel M Target 4

Show Crt -

3. Click Analyze, then save the experiment.
4. In the Export screen, ensure that the only Results is selected.

5. Select a location and file name, select *.txt in the File Type dropdown list, then click Start Export.

Analyze results in CopyCaller™ Software

The recommended settings in CopyCaller™ Software are described. See “CopyCaller™ Software
analysis options” on page 113 for other analysis options.

1. In the software, select File » Import, select the file that was exported from the instrument software,
then click Open.

2. In the Assay Selection Table, click row(s) to select one or more assays, then click & (Analysis
Settings).
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3. In the Analysis Settings window:

® Select With calibrator sample

* For Calibrator Sample: select Median C;

* For Calibrator sample copy number: enter 2

YOTI

Analyze results in CopyCaller™ Software

Note: Enter 1 for GSTT1 and GSTM1 assays.

4. Click Apply.

The data are analyzed using the selected analysis settings.

CopyCaller™ Software analysis options

Analysis method

Description

How to select

Recommended:
Median C;

Copy number results are based on the
copy number of the sample with the
median C; or median C; value. This
method works well when most samples
have the same copy number.

1. Select With Calibrator Sample.

In the Calibrator Sample Name drop-
down list, select Median C;.

Most frequent copy

Copy number results are based on the

1. Select Without Calibrator Sample.

number assumption that most samples have the In the Most Frequent Sample Copy
same copy number. Number field, enter the expected
value (Usually 2. Enter 1 for GSTM1
& GSTTH1).
Calibrator Copy number results are based on 1. Select With Calibrator Sample.

the copy number designated for one
calibrator sample.

Include a calibrator sample on each
plate.

IMPORTANT! The calibrator should be
of the same sample type as the test
samples.

. (Optional) Change Calibrator Sample

In the Calibrator Sample Name drop-
down list, select or enter a sample to
use as the calibrator.

Copy Number (default = 2).
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Review the copy number analysis data

1. In the Assay Selection Table, select the checkbox to the left of the analyzed assay to display the
copy number analysis data.

2. Review the copy number analysis data to confirm that it meets the following criteria:

Criteria Viewing tool

Samples have comparable VIC™ C; values Well and Results tables

Standard deviation is low for replicates (<0.15) Results table

Calculated copy number values are close to integer values Results table and Copy Number
Plot

Confidence and |Z-score| values are acceptable for the predicted Results table

copy number calls

Copy number of control samples is as expected Results table and Copy Number
Plot

Copy number variation frequency is within the expected range Results table and Copy Number
Plot

Samples cluster into well-defined, well-separated copy number AC; plot

groups

3. Review the quality metrics. |Z-score] Status

For sample copy number calls having confidence <175 Pass

values =95%, consider passing or failing the call based '

on the |Z-score| value as shown in the table. |Z-score] 2.656>z=1.75 Pass with caution

is only evaluated for high confidence samples. >2.65 Fail

Passing the default 95% confidence threshold and
|Z-score| of <1.75 is very achievable for good quality samples having 1-3 copies and is more
difficult to achieve for lower quality samples carrying duplications or for higher copy samples.

Consider passing samples with calls of =3 copies that fall below the 95% confidence level if:
* The calculated copy humbers are close to integer values.
* The samples cluster with passing samples of the same copy number group in the AC; plot.
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Troubleshoot with cycling and imaging run images (QC images) . ..........coiiiiiieaon... 115
OpenArray™ AccuFill™ Instrument plate loading errors .............cooeiiiiieeineenn.n.. 116
OpenArray™ Plate assembly and handling errors ..............oueiiriiieineiieannnnn.. 118
Troubleshooting unexpected genotypingresults . .......... . i 120
Troubleshooting genotype calls for assays with merging clusters .......................... 121
Expected versus unexpected noamp and undeterminedcalls .............. ... ... .. ... ... 123

WARNING! Read the Safety Data Sheets (SDSs) and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves. Safety Data Sheets (SDSs) are available from
thermofisher.com/support.

Troubleshoot with cycling and imaging run images (QC
images)

Many problems with OpenArray™ results can be diagnosed by examining the quality control (QC)
images taken at various points during a cycling/imaging run.

The QC images are fluorescent or reflected light images taken before, during, and after cycling. They
may require adjustment to make image features visible. To view the images, we recommend that you
install the free software program Imaged, which allows you to easily manipulate the images in ways that
other image viewers cannot.

1. In the QuantStudio™ 12K Flex Software Export screen £~ :
a. Click Browse to select a uniquely-named folder for the QC images export.

b. Click Export QC Images (bottom of screen).

IMPORTANT! Select a new folder for images each time; exporting a second run to the same
folder overwrites the images.

2. Use Imaged to view the images of interest.

To... View image... Image description
Confirm the identity of BARCODE IMAGE.tiff Reflected light image of the
images within a folder entire OpenArray™ Plate.
Evaluate the loading quality | PRE-READ_CHANNEL_4.tiff Pre- and post-ROX™ dye
POST-READ_CHANNEL_4.tiff images.
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Appendix A Troubleshooting
OpenArray™ AccuFill™ Instrument plate loading errors

(continued)
To... View image... Image description
Check for existing s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiff!l | Pre-run reflected light
contamination on the case spotfinding image (used by
and/or heated cover the software to determine the

location of the holes).

Identify potential leaks or s03_c001_t03_p0001_m2_x3_e1_cp#_spotfind.tiff!l | Mid-run reflected light
other contamination spotfinding image.

s04_c001_t02_p0001_m2_x3_e1_cp#_spotfind.tiffl!l | Post-run reflected light
spotfinding image.

Look at patterns in STAGEx_CYCLEy_CHANNEL_z.tiff FAM™ (z=1) or VIC™ (z=2)

the fluorescent data (for images at a particular cycle (y)

example, gradients) of a particular stage (x) of the
run.

U The “cp#” in the image file name refers to the array position (1-4) within the QuantStudio™ 12K Flex Real-Time PCR Instrument.

3. (Optional) Adjust the images for brightness and/or contrast to make image features visible.

a. Open the image in Imaged.
b. Select Image » Adjust Brightness/Contrast (or press Ctrl+Shift+C).

c. Click Auto or adjust the sliders until the features of interest in the image are visible.

OpenArray™ AccuFill™ Instrument plate loading errors

Observation Possible cause Recommended action
There are empty through-holes Insufficient sample was Use proper pipetting

added to the 384-well techniques. Ensure that there

Sample Plate. are no air bubbles in the
pipette tips after sample
aspiration.

Reaction mix (sample + Centrifuge the plate at

master mix) is not at the 1,200 x g for 60 seconds.

bottom of the 384-well
Sample Plate.
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OpenArray™ AccuFill™ Instrument plate loading errors

Observation

Possible cause

Recommended action

Turn-holes are repeatedly missed

The OpenArray™ AccuFill™
Instrument is aligned too far
to the left or to the right.

Systematic loading problems
can occur with the
OpenArray™ AccuFill™
Instrument, which indicates
a need for service. For
example, when turn-holes
are repeatedly missed across
multiple subarrays, service

is required. Turn-holes

are where the instrument
changes direction during
sample loading.

06900690
OO OO OO0
OO OO OO0
OO OO0 OO0
OO OO OO0
OO OO OO0
@@ OO 0000
Q006000

@ Turn holes
© Start points
@ Stop points

Contact your local field
service engineer.

Entire subarrays are missing

The sample/master mix was
not added to particular wells
in the 384-well Sample Plate.

Visually inspect the plate to
ensure that the wells have
sample/master mix.

Stuck tip mandrel on

the OpenArray™ AccuFill™
Instrument may need
cleaning.

Contact your local field
service engineer.

Pipette tip was not loaded on
mandrel.

Contact your local field
service engineer for frequent
occurrences (infrequent
occurrences can be due to a
poorly molded tip).
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Appendix A Troubleshooting
OpenArray™ Plate assembly and handling errors

OpenArray™ Plate assembly and handling errors

Observation

Possible cause

Recommended action

Case leaks and bubbles inside the case

Improper sealing of the OpenArray™ Plate in the
OpenArray™ Case can lead to immersion fluid
leaks or bubble formation inside the case, leading
to uneven heating and imaging throughout PCR
and to poor quality data.

The images above are examples of OpenArray™
Plates that have been affected by immersion fluid
leaks. The images show where leaked fluid has
condensed on the underside of the heated cover
windows and obscured the view of the through-
holes.

The best image in which to detect leaks is the
s03_c001_t03_p0001_m2_x3_e1_cp#_spotfind.tiff
image. This image is taken at the start of

cycling, which is where most leaks occur. See
“Troubleshoot with cycling and imaging run
images (QC images)” on page 115.

Plate press was not engaged
for at least 20 seconds.

Fully engage the plate press
for at least 20 seconds.

Damaged lid adhesive.

Remove the liner and visually
inspect the lid adhesives for
defects. Ensure that adhesive
is not damaged or warped.

Damaged fill port screw
gasket.

Visually inspect the screw to
ensure that the orange gasket
is present and not damaged.

Damaged fill port screw
assembly. Breaks off too
easily.

The screw may be mis-
threaded: unscrew it and use
a new screw assembly.

Oily lid or case from
immersion fluid overflow.

Wipe off excess overflow

of immersion fluid from

the lid, case bottom, and
crevices with 70% isopropyl
alcohol, using a lint-free
cloth (the cloth included
with the OpenArray™ Plate is
acceptable).

Immersion fluid was exposed
to air for too long.

Do not remove the immersion
fluid syringe cap or draw air
bubbles into the syringe until
you are ready to load.

Too large of a bubble inside
the OpenArray™ Case after
sealing.

Minimize the size of the
bubble by tilting the
OpenArray™ Case so that the
fill port is at the highest

point. Slowly fill the case

with immersion fluid until only
a small air bubble remains.
Attach the screw and wipe off
any excess oil that may have
spilled onto the case.

Damaged plate press, leading
to uneven pressure.

Contact your field service
engineer if you suspect that
your plate press may be
damaged.
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Appendix A Troubleshooting

OpenArray™ Plate assembly and handling errors

Observation

Possible cause

Recommended action

Sample blow-out during the addition of immersion
fluid

The reactions in A12 were
compromised during the
addition of immersion fluid.
Injecting the immersion fluid
too quickly can purge the
sample out of the through-
holes near the fill port. Often
this is caused by the user not
purging the syringe slightly
before use.

Dispense a small amount
of immersion fluid onto a
paper towel before use to
ensure smooth operation of
the syringe.

Evaporation of reaction mixture in through-holes

Too much time elapsed
before the plate was sealed
with lid and immersion fluid.
In this example, the top

half of each subarray was
intentionally left open to the
environment to demonstrate
the effect of evaporation.
“Donuts” are a result of

the evaporated fluid in the
though-holes.

Add immersion fluid as soon
as the case is removed from
the plate press to minimize
the likelihood of evaporation,
then seal the case with the
lid.
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Troubleshooting unexpected genotyping results

Troubleshooting unexpected genotyping results

The following table pertains to TagMan™ SNP Genotyping Assays run on OpenArray™systems.
For a comprehensive guide to troubleshooting SNP assay performance, refer to “Appendix A:
Troubleshooting” in the TagMan™ SNP Genotyping Assays User Guide. (Pub. No. MAN0009593).

Observation

Possible cause

Recommended action

Diffuse clusters, loss of
heterozygosity, and/or non-
amplification for many
samples in a dataset

Insufficient amount of starting
DNA and/or PCR inhibitors
present in the sample
preparation.

We recommend using 50 ng/pL as the starting
DNA concentration. If it is not possible to increase
the concentration of the starting material or
remove inhibitors from the sample preparation,
preamplify the sample. See the TagMan™
OpenArray™ Genotyping Sample Preamplification
User Bulletin (Pub. No. MANO011116).

The images show poor quality SNP data (top)
that is improved by preamplifying the samples
(bottom).
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Amplification plot is missing
expected cluster

Signal saturation caused
software to call homozygous
alleles as heterozygous (or
vice versa).

Use real-time traces to manually call alleles.
See “Recommended: Run OpenArray™ SNP
genotyping experiments in real-time mode” on
page 49 for more information.
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Appendix A Troubleshooting
Troubleshooting genotype calls for assays with merging clusters

Observation Possible cause Recommended action
Incorrect genotype called Real-time traces were not Use real-time traces to identify outlier data points
used to identify outlier data and to manually call alleles.
points.

Real-time traces can be viewed in the
QuantStudio™ 12K Flex Software or the Connect
Genotyping Module, which is accessed from
thermofisher.com/cloud.

See “Recommended: Run OpenArray™ SNP
genotyping experiments in real-time mode” on
page 49 for more information.

(Optional) Rerun samples that fail to cluster

If a sample fails to cluster well with other samples or fails to amplify properly with one or more assays
(that is, there are UND and NOAMP calls in the run), rerun such samples using single tube DME assays
on 96-well or 384-well plates. We recommend running control gDNA samples along with the unknown
samples or use a reference panel (see “(Optional) Generate a reference panel” on page 100). The
controls will help to provide more accurate genotype calling of the unknown samples.

Troubleshooting genotype calls for assays with merging
clusters

It can be difficult for the secondary analysis software (for example,TagMan™ Genotyper Software) to
make distinct genotype calls for assays with merging clusters (see example below). In these cases,

use the real-time traces from the QuantStudio™ 12K Flex Software to review the data by assay and
manually call data as necessary. Manually adjust the end-point cycle number to an earlier cycle using
the Reveal Traces scroll bar; the clusters will have a greater degree of separation. Use this adjustment if
any real-time traces do not show a smooth progression in signal throughout the run.
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Appendix A Troubleshooting
Troubleshooting genotype calls for assays with merging clusters
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Options

[#] Reveal Traces  Show Cycle: 40

To

1.

2.

manually adjust the the end-point cycle number:

Open the experiment.

Select Analysis » Allelic Discrimination Plot from the Experiment Menu pane on the left.
Select the Options icon (circled in red).

Select Reveal traces.

Use the slider to adjust the end-point cycle number and optimize allele discrimination between
genotype clusters.

Click Analyze to update genotype calls.

Save the run. Take note of the cycle number for each assay that has been adjusted. These
numbers can later be entered into the TagMan™ Genotyper Software.

Note: A lower call cycle presently does not transfer to the TagMan™ Genotyper Software. The
software will re-set the cycle number to 50 cycles. Set up a separate study with the lower cycle
number.

(Optional) Select Analysis » QC Summary from the Experiment Menu pane to view the QC flags
for the run.

Click each flag to display its meaning, and a troubleshooting link appears in the right-side pane.

Note: Ignore the CTFAIL flag for genotyping data. Some samples do not have both alleles present.
This flag displays the amplification curve from the absent allele does not meet quality metrics, but
the ampilification will be poor if an allele is absent.

Pharmacogenomics Experiments Application Guide



Appendix A Troubleshooting
Expected versus unexpected noamp and undetermined calls

Expected versus unexpected noamp and undetermined
calls

For certain assays, it is expected that there will be some samples that legitimately fail to amplify or have
an undetermined genotype call. These include samples run with assays that interrogate gene variants
that are associated with copy number variation and with assays that detect triallelic SNPs or adjacent
SNPs. See “Analysis guidelines: DME genotyping assays for genes in copy number variation regions”
on page 103 and “Analysis guidelines: SNP genotyping assays for triallelic SNPs” on page 103 for
details on how to analyze the data for such assays.

TagMan™ Drug Metabolism Genotyping Assays for genes in copy number
variation regions

Some TagMan™ Drug Metabolism Genotyping Assays target polymorphisms in genes that exhibit copy
number variation. Copy number variation analysis must be done in addition to genotyping with DME
assays.

* [f both copies of a gene are deleted in a sample (copy number of 0), samples will not be amplified
and will run near or with the NTCs.

* [f a sample contains more than 2 copies of a gene and both SNP alleles are present, it will fall
within the heterozygous cluster or occasionally to one side or the other of it, in which case it may
be called as undetermined. These should be manually called as heterozygous for data analysis
purposes.

TagMan™ Drug Metabolism Genotyping Assays for triallelic SNPs and
adjacent SNP targets

Triallelic SNP and adjacent SNP targets can be interrogated using a pair of Custom TagMan™ SNP
Genotyping Assays. Each assay contains one probe for the major SNP allele or haplotype and one
probe for one of the minor alleles or haplotypes. After running paired assays in separate reactions
on the same genomic DNA samples, compare the results of the two assays to determine the sample
genotype. For a given assay it is expected that:

¢ Samples containing one reported allele may run close to or within a homozygous cluster. Any
samples running close to homozygous clusters that are called as undetermined should be manually
called as homozygous for data analysis purposes.

¢ Samples that are homozygous for the unreported allele may cluster with NTCs or may exhibit
weak amplification due to probe nonspecific activity. If a weakly amplifying sample is called as
undetermined, manually adjust the call to "noamp".
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Preamplification of low-
concentration gDNA
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Preamplification in OpenArray™ experiments helps to ensure sufficient template copies in the 33-nL
gPCR reaction. At low template copy numbers, stochastic effects can dominate the reaction because
the random events at each template molecule represent a large portion of the potential extension
events. Stochastic events in gPCR reactions are generally dominant at levels of <10 template copies
and negligible at levels of >100 template copies.

The standard OpenArray™ protocol for human SNP assays recommends starting with 50 ng/uL of
genomic DNA. When diluted 50% in master mix and loaded into a 33-nL reaction chamber, the final
template amount is 825 pg. This converts to 250 genomic copies (125 genomic copies for each allele in
a heterozygote).

Preamplification can also be used to dilute PCR inhibitors from sample preparations that are of
sufficient DNA concentration but contain impurities, and therefore do not amplify well with the TagMan™
OpenArray™ Genotyping Master Mix.

This protocol describes targeted multiplex preamplification of 1 to 256 SNP loci located in human
genomic DNA samples. A multiplex pool of TagMan™ SNP Genotyping Assays is used to simultaneously
preamplify up to 256 target polymorphisms in a single reaction using a reduced amount of input DNA
sample.

The preamplification product can be used as the sample template input for SNP genotyping reactions
with any of the individual TagMan™ SNP Genotyping Assays included in the multiplex preamplification
assay pool. Perform genotyping experiments using the individual TagMan™ SNP Genotyping Assays
following the standard protocol except substituting preamplified product for genomic DNA sample. It
is not necessary to quantify or normalize preamplified product. The preamplified sample can be added
directly into the reaction plate or further diluted in 1X TE Buffer to the desired concentration.

For specific applications, a custom OpenArray™ Preamp Pool specific for your TagMan™ SNP assay
panel can be ordered along with your OpenArray™ plate (contact your sales representative for details).
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Appendix B Preamplification of low-concentration gDNA
Guidelines for starting DNA sample concentration

Note: The protocol is compatible with TagMan™ SNP Genotyping Assays, but is not recommended for
use with TagMan™ Copy Number Assays.

Guidelines for starting DNA sample concentration

DNA sample
concentration

Preamplification

Recommendation

<0.4 ng/pL

Not recommended

Preamplification of DNA at concentrations <0.4 ng/uL is not
recommended, due to the potential for stochastic events arising from
low target number in the early rounds of the preamplification and gPCR
reactions.

0.4 ng/pL to 4.0
ng/uL

Ideal
preamplification
range

The preamplification protocol was developed using genomic DNA
samples within a starting concentration range of 0.4 ng/pL to 4.0 ng/pL
and a total of 0.5 ng to 5 ng in the preamplification reaction.

Optimal performance will be achieved if the starting concentration

of genomic DNA samples is near the middle of the working range

(2.5 ng/uL). Our recommended protocol for accurate quantification of
human gDNA samples using the RNase P Detection Reagents Kit can
be found in Appendix B of the Pharmacogenomics Experiments User
Guide.

4 ng/uL to 25 ng/uL

User discretion

Samples at these concentrations may be preamplified without dilution,
but these are out of the optimal range.

>25 ng/pL

Not recommended

Samples with DNA sample concentrations >25 ng/pL do not require
preamplification. If samples at these concentrations do not amplify well
with SNP assays, they likely contain PCR inhibitors. If this is the case,
high concentration DNA samples may yield good results after dilution,
and preamplification of these samples may be unnecessary.

Note: 1 ng of human genomic DNA = 300 genomic copies or 150 copies of each allele in a

heterozygote.
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Appendix B Preamplification of low-concentration gDNA

Required materials

Required materials

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Reagent Cat. No.
TagMan™ PreAmp Master Mix 4391128
OpenArray™ PreAmp Pool 44852551

Genomic DNA Samples

Supplied by user

1X TE Buffer, pH 8.0

12090015

Nuclease-free water

MLS

1 Cannot be ordered online. For information on ordering an OpenArray™ Preamp Pool, contact your sales representative.

Perform the preampilification

1. Prepare the individual preamplification reactions as shown in the following table.

Note: It is convenient to use plates with well volumes that can accommodate a 20X larger volume
than the reaction for the 20-fold dilution step after preamplification.

Note: TagMan™ PreAmp Master Mix and OpenArray™ PreAmp Pool can be prepared as a single
reaction mix and distributed to the plate in 3.75 pL aliquots. These volumes can be increased
2-fold if more preamplified product is needed.

Component Stock concentration Final concentration Volume
TagMan™ PreAmp Master Mix 2X 1X 25puL
OpenArray™ PreAmp Pool 4X (0.20X each assay) 1X (0.05X each assay) 1.25 uL
Genomic DNA Sample 0.4 ng/pL to 4 ng/pL 0.1 ng/pL to 1 ng/puL 1.25 L

(versus 150-1500 copies per pL)
Total - - 5.0 yL

2. Firmly seal the reaction plate with a MicroAmp™ Clear Adhesive Film.

3. Vortex the reaction plate for 10 seconds, then centrifuge briefly.
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Appendix B Preampilification of low-concentration gDNA
Dilute and store the preamplified product

4. Run the preamplification cycling program on a GeneAmp™ PCR System 9700 (silver or gold block)
or Veriti™ Thermal Cycler using the following thermal cycling conditions.

Stage Step Temp Time
Hold Activate 95°C 10 minutes
Cycling (10 to 14 cycles) Denature 95°C 15 seconds
Anneal/Extend 60°C 4 minutes
Hold Inactivate 99.9°C 10 minutes
Hold - 4°C up to 1 hour or overnight

5. Transfer the reaction plate from the thermal cycler to a container with ice. Keep the plate on ice
until you are ready to dilute the preamplified product.

Dilute and store the preamplified product

—

. Centrifuge the reaction plate briefly prior to removing the film.

N

Remove the film, then add 95 pL of 1X TE Buffer to each well containing a preamplified product, to
create a 1:20 dilution.

1

Seal the reaction plate with a new MicroAmp™ Clear Adhesive Film.

P

Vortex the reaction plate for 10 seconds, then centrifuge briefly.

o

Store the preamplified product at -25°C to —15°C.
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RNase P quantification for
genotyping experiments

In this procedure, the quantification method uses TagMan™ Control Genomic DNA (human) as a
calibrator instead of a standard curve. The SampleFile 384-Well Plate 192-Format.xlsx
calculates the concentration of test DNA samples with this calibrator method.

Note: The SampleFile 384-Well Plate 192-Format.xlsx assumes duplicate RNase P
reactions in a 384-well plate layout.

Download the SampleFile 384-Well Plate 192-Format.xlsx from thermofisher.com/oaqrc.

Required materials

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

ltem Cat. No.
TagMan™ Copy Number Reference Assay, human, RNase P (20X) 4403326
TagMan™ Control Genomic DNA (human) (ready for use) 4312660
TagPath™ ProAmp™ Master Mix A30865

Before you begin

128

Dilute test DNA samples 1:10 in nuclease-free water.

Determine the total number of reactions required by including the following items:
— Diluted test DNA samples
— Calibrator DNA sample
— No template control (NTC) reactions (use nuclease-free water in place of DNA sample)

Note: We recommend a minimum of two reactions for each sample. The SampleFile 384-Well
Plate 192-Format.xlsx is set up for duplicate reactions.

Generate the RNase P Sample TXT file from the SampleFile 384-Well Plate 192-
Format.xlsx.
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Appendix C RNase P quantification for genotyping experiments
Set up and run the PCR, then quantify the DNA

Set up and run the PCR, then quantify the DNA

1. Prepare a reaction mix for the required number of reactions plus 10% overage.

Component Volume per reaction(!!
TagPath™ ProAmp™ Master Mix 5.0 L
TagMan™ Copy Number Reference Assay, human, RNase P (20X) 0.5 L
Nuclease-free Water 2.5 L
Total 8 uL

[ See the SampleFile 384-Well Plate 192-Format.xlsx to calculate volumes for multiple reactions.

2. Transfer 8 pL of the reaction mix to the wells of a 384-well PCR reaction plate.

3. Add 2 pL of sample DNA, TagMan™ Control Genomic DNA (human), or nuclease-free water to the

appropriate wells.

4. Seal the plate with optical film.

5. Set up the real-time instrument with the following thermal cycling conditions and settings:

Step Temperature Time Cycles
Enzyme activation 95°C 10 minutes 1
Denature 95°C 15 seconds
Anneal/Extend 60°C 60 seconds “0

* Experiment type: Standard Curve
* Mode: Standard

* Reporter: VIC™

* Quencher: TAMRA™

* Passive reference: ROX

6. To assign the sample names, import the RNase P Sample TXT file generated from the

SampleFile 384-Well Plate 192-Format.xlsx.

7. Load the plate, then start the run.

8. After the run is complete, deselect all but the Results tab, select a file location, then export the

results.

9. Remove duplicate sample IDs from the exported data by opening the exported data file in Excel™,

then:

a. Copy-paste sample names and their corresponding C; mean values into a new sheet.

b. Select both columns and use the Remove Duplicates function.
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Appendix C RNase P quantification for genotyping experiments
Set up and run the PCR, then quantify the DNA

10. Calculate the concentration of test DNA samples:

a. Copy- paste the Sample Names and Mean C; values into the SampleFile 384-Well
Plate 192-Format.xlsx.

b. Enter the dilution factor of the test DNA samples into the SampleFile 384-Well
Plate 192-Format.xlsx.

130 Pharmacogenomics Experiments Application Guide



Controls for genotyping and copy
number experiments

Overview

Laboratories can verify the performance of selected TagMan™ SNP Genotyping Assays and TagMan™
Drug Metabolism Genotyping Assays on OpenArray™ plates by using samples that represent all three
genotypes (homozygous major allele, homozygous minor allele, and heterozygous) to test for both
amplification and cluster separation. A laboratory may prefer to use samples that represent at least
two genotypes (homozygous major and minor alleles, or homozygous major allele and heterozygous)
to test that both assay probes function. Ideally, gDNA samples of known genotypes are used for such
experiments. However, for rare DME variants that are not well-represented in populations, it may be
necessary to use synthetic templates.

This Appendix includes information on sources of control cell line sample DNAs for DME and SNP
genotyping assays, as well as for copy number assays. It also includes information on ordering
synthetic template DNAs in plasmids.

Sources of reference materials

This section describes some publicly available sources for reference or control materials that can be
used in genetic testing and assay performance experiments.

TagMan™ Drug Metabolism Genotyping Assays test data

All TagMan™ Drug Metabolism Genotyping Assays were run on 180 unique DNA samples from four
different populations in assay performance and reproducibility testing. Samples tested included a panel
of 45 African American and 45 Caucasian samples obtained from the Coriell Cell Repositories and a
panel of 45 Japanese and 45 Chinese samples provided by a collaborator. The minor allele frequencies
determined for each assay are provided at thermofisher.com (assay search results) and in the DME
Index.

Note: Many of the polymorphisms interrogated by this assay collection have very low minor allele
frequencies (MAFs) of less than 1%; thus, the minor allele was not detected for all assays within the 180
test samples.

For TagMan™ Drug Metabolism Genotyping Assays having a reported Applied Biosystems™ MAF in the
African American or Caucasian populations, heterozygous or minor allele homozygous samples may be
used as reference or control samples in genetic testing and assay performance studies. A complete list
of the samples used and their genotypes is available at thermofisher.com.
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Appendix D Controls for genotyping and copy number experiments
Sources of reference materials

Order the gDNA samples from the Coriell Cell Repositories at http://ccr.coriell.org. Please note that
the genotypes of these samples were, for the most part, not verified by sequence analysis.

NCBI dbSNP genotype data

Another source of DME assay control samples is the refSNP submissions in the NCBI database of Short
Genetic Variations (dbSNP) at www.ncbi.nlm.nih.gov/SNP.

Search the database by rs ID to navigate to specific refSNP pages that may have genotype information
for variants of interest, noted in the Allele summary box or the Population Diversity table. Cell line gDNA
samples are available from the Coriell Institute biorepositories (https://catalog.coriell.org) for samples
sequenced in the 1000 Genomes project or genotyped in the International HapMap project.

* 10009 controls: if the Allele summary box contains MAF/MinorAlleleCount information from the
1000 Genomes project, navigate to the 1000 Genomes browser (www.ncbi.nlm.nih.gov/variation/
tools/1000genomes) and search by rs ID. This will return a genotype results table for the SNP
and neighboring SNPs for all 2500 samples used in the project, grouped by population. Expand a
population to view individual samples and their genotypes

* HapMap controls: if the Population Diversity table contains genotype information from the HapMap
project, the sample genotypes can be found by clicking on the submission ss # to navigate to
the submission details page. For HapMap samples, the sample genotypes can also be found at
the HapMap web site (http://hapmap.ncbi.nim.nih.gov). A subset of the HapMap samples were
sequenced by the 1000g project.

Centers for Disease Control and Prevention (CDC) reference materials

Clinical Laboratory Improvement Amendments (CLIA)
wwwhn.cdc.gov/clia/Resources/GETRM/default.aspx

The Centers for Disease Control and Prevention (CDC) provides genetic information on cell line DNAs
that can be used as reference materials for genetic testing and assay validation. Some of these cell
lines were characterized by the Genetic Testing Reference Materials Coordination Program (GeT-RM).
One major focus category is the ‘Genetic Inherited Disease & Pharmacogenetics’ section. Download
tables of reference samples that contain PGx/DME or disease allele variants, many of which have been
confirmed by multiple labs and genetic testing technologies, can be downloaded from:wwwn.cdc.gov/
clia/Resources/GETRM/MaterialsAvailability.aspx

TagMan™ Copy Number Assays for DME genes

132

Several DME genes occur in CNV regions (see “DME genes and copy number variation” on page 17). In
addition, the CYP2D6 and CYP2A6 genes are known to recombine with related pseudogene sequences
to generate hybrid genes, many of which have decreased or null gene activity. TagMan™ Copy Number
Assays can be used to detect deletions, duplications, and hybrid gene alleles. TagMan™ Copy Number
Assays for the major known DME genes that exhibit CNV have been pre-tested on a panel of 45

each African American and Caucasian (the same samples as were used for TagMan™ Drug Metabolism
Genotyping Assay validation studies). A complete list of the samples used and their genotypes is
available at www.thermofisher.com/pgx.

The gDNA samples can be ordered from the Coriell Cell Repositories website (http://ccr.coriell.org).
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Appendix D Controls for genotyping and copy number experiments
Plasmid controls

Plasmid controls

We have successfully used synthetic major and minor allele template DNAs cloned into plasmids

to test the performance of over 300 TagMan™ DME Assays. In addition to major or minor allele
sequences, plasmids carry the RNase P RPPH1 gene for accurate quantitation of plasmids by

the standard curve analysis before use in genotyping experiments. Equal quantities of major and
minor allele plasmids are mixed together to create heterozygous controls. Use the homozygous and
heterozygous plasmid controls to demonstrate amplification and detection of all three genotypes by
a given assay. Plasmid control samples often, but not always, cluster with gDNA samples. Review
example data in the TagMan™ Drug Metabolism Genotyping Assays on OpenArray™ Plates PPT file
from: www.thermofisher.com/pgx.

For information on ordering TagMan™ DME and SNP Genotyping Assay plasmid controls, email
GeneArtSupport@thermofisher.com.
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Good PCR practice

Prevent contamination and non-specific amplification

PCR assays require special laboratory practices to avoid false positive amplifications. The high
throughput and repetition of these assays can lead to amplification of one DNA molecule.

PCR good laboratory practices

When preparing samples for PCR amplification:

134

Use a positive-displacement pipette or aerosol-resistant pipette tips.
Follow proper pipette-dispensing techniques to prevent aerosols.

Wear clean gloves and a clean lab coat (not previously worn while handling amplified PCR products
or used during sample preparation).

Change gloves whenever you suspect that they are contaminated.
Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation
— PCR setup
— PCR ampilification
- Analysis of PCR products
Do not bring amplified PCR products into the PCR setup area.

Open and close all sample tubes carefully. Centrifuge tubes before opening. Avoid splashing or
spraying PCR samples.

Keep reactions and components capped as much as possible.

Clean lab benches and equipment periodically with 10% bleach solution. Use DNAZap™ PCR DNA
Degradation Solutions (Cat. No. AM9890).
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, see the “Documentation and Support” section in this document.
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Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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Biological hazard safety

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
https://www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-
P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document Pub. No.
Thermo Scientific™ KingFisher™ Flex User Manual NO07669
MagMAX™ DNA Multi-Sample Ultra Kit MagMAX™ Express-96 Magnetic Particle Processor 4428202
Protocol
MagMAX™ DNA Multi-Sample Ultra Kit (whole blood) User Guide MANO0010294
Best Practices for Collection of Buccal Swabs for Genotyping Experiments MANO0014348
Isolation of DNA for Genotyping Experiments MANO0014561
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ SNP Genotyping Experiments MANO0014351
OpenArray™ Genotyping Analysis MANO0014352
TagMan™QOpenArray™ Genotyping Troubleshooting Guide MANO0011115
TagMan™ Genotyper Software Getting Started Guide 4448637
TagMan™ SNP Genotyping Assays User Guide MANO0009593
TagMan™ Drug Metabolism Assays for Triallelic SNPs Application Note 135AP01-01
Copy Number Analysis for Pharmacogenomics Experiments MANO0014350
RNase P Quantification for Genotyping Experiments MANO0014349
Creating Standard Curves with Genomic DNA or Plasmid DNA Templates for Use in 4371090
Quantitative PCR Application Note
TagMan™ Copy Number Assays User Guide 4397425
CYP2D6 Allele-specific Copy Number Analysis Quick Reference MANO011114
Copy Number Analysis for Pharmacogenomics Experiments MANO0014350
CopyCaller™ Software v2.0 User Guide 4400042

QuantStudio™ 12K Flex Real-Time PCR System Software Help -

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Plate Quick Reference 4478673

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
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Customer and technical support

(continued)

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System Maintenance and Administration Guide 4470689
OpenArray™ AccufFill™ System User Guide, for OpenArray™ AccuFill™ Software v1.2 4456986

OpenArray™ Sample Tracker Software Quick Reference, for OpenArray™ AccuFill™ Software 4460657
vi.2

QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide, for OpenArray™ AccuFill™ | MAN0025669
Software v2.0

OpenArray™ AccufFill™ Software v2.0 Full Run Workflow Quick Reference MANO0025836

OpenArray™ AccufFill™ Software v2.0 Quick Run Workflow Without Sample Information Quick | MAN0025835
Reference

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers

* Product support information
- Product FAQs

- Software, patches, and updates
— Training for many applications and instruments
* Order and web support
* Product documentation
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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